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1 Introduction

1.1 What is FeedFor All

RSS feeds are an easy, flexible tool for syndicating content on the Internet. This enables RSS users to
choose what content they want, and view it on their own schedule.  FeedForAll is a comprehensive tool
for creating, editing, repairing, and enhancing RSS feeds and podcasts.  Enter your data and content into
the easy to use Feed Creation Wizard, or into clearly labeled forms and FeedForAll creates a
professional, standards compliant RSS feed or podcast, that will work with readers, aggregators,
browsers, and other applications and devices designed for RSS.

"RSS" stands for "Really Simple Syndication," but if you have ever tried to create an RSS file manually
you know it's not that simple.  That's where FeedForAll comes in.  Create and edit RSS feeds with easily
understandable screens and FeedForAll does all the hard work to get your content onto the Web.  News,
information, articles and even sound and video podcasts are quickly assembled in a convenient interface,
then published to your Web site.

Use FeedForAll to repair and enhance existing RSS feeds and podcasts, to conform to the RSS 2.0
specification, even if they were generated by other means.  Existing feeds are enhanced with advanced
properties,  giving them a more professional look.

Handle your day to day feed maintenance simply with FeedForAll.  Features such as automatic
publication date handling and field defaults enable you to keep your feeds up-to-date, with minimal effort.

Whether you are creating a simple text feed or an advanced podcast, FeedForAll has what you need to
create and maintain functional and professional RSS feeds.
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1.2 Features & Benefits

· Multiple RSS version support
FeedForAll can read RSS version 2.0, 0.94, 0.93, 0.92, 0.91, and 0.9 feeds. FeedForAll also provides
limited Atom .3 support.

· iTunes support

 Complete support for creating iTunes podcasts.

· Customizable interface
You can choose from an assortment of interface skins to personalize the look and feel of FeedForAll.
A pleasing interface can increase productivity.

 Improved Preference screen navigation

· Download existing feeds
FeedForAll can download existing RSS feeds from the Internet. This will allow you to easily modify,
enhance, and update existing feeds.

· Open existing feeds
FeedForAll can open existing RSS feeds from disk. This will allow you to easily modify, enhance, and
update existing feeds.

· Automatic feed repair
FeedForAll automatically repairs all malformed feeds that it opens. This enables FeedForAll to open
feeds that other programs are unable to open. This also ensures that all feeds saved with FeedForAll
are in a valid format.

· Automatic date management
FeedForAll atomically maintains all your RSS feed dates.

· Programmable SmartDates
SmartDate buttons can be programmed to automatically advance the feed's Pub Date to the next
desired publish date

· Unlimited Feeds
FeedForAll can be used to maintain an unlimited number of RSS feeds

· Intuitive User Interface
FeedForAll has a simple yet powerful user interface that makes feed creation easy for both beginners
and experienced users.

· Spell Checker
FeedForAll's built in live spell checking will insure professional looking feeds.

· Support for All RSS Fields and Attributes
FeedForAll supports ALL fields and attributes as documented in the RSS 2.0 specification.

· Feed Image Support
FeedForAll fully supports and displays RSS feed images.

· Language Support

 Full Unicode support for all languages in all feeds

 UTF-8 Support for non-Latin characters.
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 Set default font

· Extension (Namespace) support

 iTunes extension (namespace) support

 Dublin Core extension (namespace) support

 Content extension (namespace) support

 Syndication extension (namespace) support

· Image Editor
FeedForAll's built in image editor has advanced image manipulation features including automatic
image scaling.

· WYSIWYG HTML Editor
Use FeedForAll's WYSIWYG HTML editor to easily create visually appealing feed descriptions.

 Easily insert an image into the description field.

 Improved color picker.

 Set links to open a new browser window.

 Insert images and make them into links.

 New search/replace.

 Greatly improved HTML parsing supports more tags.

 Search/Replace added to source viewer.

· Upload & Publish Feeds
FeedForAll's built in FTP capabilities enable you to easily upload and publish your RSS feeds to the
Internet.

 FTP Browsing for uploads.

 Upload images and enclosures.

 New FTP Options.

· Field Default Settings
Field default settings can be configured to save time, and eliminate the need to reenter repetitive data.

· XML Editor
FeedForAll gives savvy users the ability to manually edit a feed's formatted XML source code.

 Namespace support handled in new Extensions tab.

 XML stylesheets support

 New Advanced tab to handle XML comments support

· Preview option (with printer support)

 Feed preview option, with support for templates

· Export Support
Feeds can be exported as HTML Web pages, text files, and CSV files. Templates are used to
customize the appearance of the exported files.
New Export options.

· Search & Replace
FeedForAll includes a powerful search and replace feature that gives users a mechanism to easily
make global changes to their feeds.

· Feed Validation Function

 Feeds can now be validated within FeedForAll to ensure RSS 2.0 compliance
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1.3 Purchasing

FeedForAll can be purchased via the Internet, fax, postal mail, or phone.  Details for each ordering
method can be found below. FeedForAll is licensed per computer.  Every computer you run a copy of
FeedForAll on (after the evaluation period has expired), requires its own license.

FeedForAll Pricing: (all prices are in USD)

Single computer license $39.95 ea.

Qty. 10-49 licenses $34.95 ea.

Qty. 50+ licenses $29.95 ea.

Site* license $1995.00

Enterprise** license $2495.00

*A site license allows a business to reproduce and distribute registered copies within a single physical
location, for a fixed license fee.

**An enterprise license allows businesses to reproduce and distribute registered copies within a single
company (all locations), for a fixed license fee.

Ordering Information:

Online orders - secure online ordering is available at www.feedforall.com/order.htm. Online orders can
be paid for with Visa, MasterCard, Discover, American Express, and Eurocard.

Fax orders - a fax order form can be printed from the registration screen inside the FeedForAll program.
Orders should be faxed to (781) 829-0419. Faxed orders can be paid for with Visa, MasterCard, Discover,
American Express, and purchase orders***

Postal mail orders - an order form can be printed from the registration screen inside the FeedForAll
program.  Orders should be mailed to:

NotePage, Inc.
PO Box 296
Hanover, MA 02339

Postal mail orders can be paid for using Visa, MasterCard, Discover, American Express, checks drawn
on US banks, and purchase orders***

Phone orders - Orders can be placed over the phone at (781) 829-0500.  Phone orders can be paid for
using Visa, MasterCard, Discover, and American Express.

*** Purchase orders will only be accepted from companies or government agencies within the US. We
are unable to accept POs from outside the United States. Purchase orders must be signed and they
must include an e-mail address.

All orders require a valid email address for processing.

http://www.feedforall.com/order.htm
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1.4 End User License Agreement

END-USER LICENSE AGREEMENT FOR FeedForAll

IMPORTANT: PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT
CAREFULLY BEFORE CONTINUING USE OF THIS PRODUCT:

NotePage, Inc.'s End-User License Agreement ("EULA") is a legal agreement between you (either an
individual or a single entity) and NotePage, Inc. for the NotePage software product(s) identified above
which may include associated software components, media, printed materials, and "online" or electronic
documentation ("SOFTWARE PRODUCT"). By installing, copying, or otherwise using the SOFTWARE
PRODUCT, you agree to be bound by the terms of this EULA. This license agreement represents the
entire agreement concerning the program between you and NotePage, Inc., (referred to as "licensor"),
and it supersedes any prior proposal, representation, or understanding between the parties.  If you do not
agree to the terms of this EULA, do not install or use the SOFTWARE PRODUCT.

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well
as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE.  The SOFTWARE PRODUCT is licensed as follows:
(a) Installation and Use. NotePage, Inc. grants you the right to install and use copies of the SOFTWARE
PRODUCT on your computer running a validly licensed copy of the operating system for which the
SOFTWARE PRODUCT was designed [e.g., Windows 95®, Windows 98®, Windows ME®, Windows
NT®, Windows 2000®, Windows XP®].
(b) Per Computer License. Ownership of The SOFTWARE PRODUCT only permits for The SOFTWARE
PRODUCT to be installed on a SINGLE computer. Ownership of The SOFTWARE PRODUCT only
permits for a SINGLE instance of The SOFTWARE PRODUCT to be run said computer. For use of The
SOFTWARE PRODUCT on additional computers, or for use of more than one instance of The
SOFTWARE PRODUCT on a single computer, additional licenses MUST be purchased.
(c) Backup Copies. You may also make copies of the SOFTWARE PRODUCT as may be necessary for
backup and archival purposes.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.
(a) Maintenance of Copyright Notices.  You must not remove or alter any copyright notices on any and
all copies of the SOFTWARE PRODUCT.
(b) Distribution. You may not distribute registered copies of the SOFTWARE PRODUCT to third parties.
Evaluation versions available for download from NotePage, Inc.'s Web sites may be freely distributed.
(c) Prohibition on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer,
decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity
is expressly permitted by applicable law notwithstanding this limitation.
(d)  Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT.
(e) Support Services. NotePage, Inc. may provide you with support services related to the SOFTWARE
PRODUCT ("Support Services").  Any supplemental software code provided to you as part of the Support
Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and conditions
of this EULA.
(f) Compliance with Applicable Laws. You must comply with all applicable laws regarding use of the
SOFTWARE PRODUCT.

3. TERMINATION
Without prejudice to any other rights, NotePage may terminate this EULA if you fail to comply with the
terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE
PRODUCT in your possession.
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4. COPYRIGHT
All title, including but not limited to copyrights, in and to the SOFTWARE PRODUCT and any copies
thereof are owned by NotePage, Inc. or its suppliers. All title and intellectual property rights in and to the
content which may be accessed through use of the SOFTWARE PRODUCT is the property of the
respective content owner and may be protected by applicable copyright or other intellectual property laws
and treaties.  This EULA grants you no rights to use such content.  All rights not expressly granted are
reserved by NotePage.

5. NO WARRANTIES
NotePage, Inc. expressly disclaims any warranty for the SOFTWARE  PRODUCT. The SOFTWARE
PRODUCT is provided "As Is" without any express or implied warranty of any kind, including but not
limited to any warranties of merchantability, noninfringement, or fitness of a particular purpose. NotePage
does not warrant or assume responsibility for the accuracy or completeness of any information, text,
graphics, links or other items contained within the SOFTWARE PRODUCT.  NotePage makes no
warranties respecting any harm that may be caused by the transmission of a computer virus, worm, time
bomb, logic bomb, or other such computer program. NotePage further expressly disclaims any warranty
or representation to Authorized Users or to any third party.

6. LIMITATION OF LIABILITY
In no event shall NotePage, Inc. be liable for any damages (including, without limitation, lost profits,
business interruption, or lost information) rising out of 'Authorized Users' use of or inability to use the
SOFTWARE PRODUCT, even if NotePage, Inc. has been advised of the possibility of such damages.  In
no event will NotePage be liable for loss of data or for indirect, special, incidental, consequential
(including lost profit), or other damages based in contract, tort or otherwise. NotePage, Inc. shall have no
liability with respect to the content of the SOFTWARE PRODUCT or any part thereof, including but not
limited to errors or omissions contained therein, libel, infringements of rights of publicity, privacy,
trademark rights, business interruption, personal injury, loss of privacy, moral rights or the disclosure of
confidential information.
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1.5 Version Information

FeedForAll help manual version 2.0

For FeedForAll version 2.0

Copyright 2004-2006 NotePage, Inc.

All rights reserved.
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1.6 What's New

FeedForAll v2.0

iTunes support
Full support for the latest iTunes podcast specification

Extension (namespace) support
Full support for iTunes, content, dublin core, and syndication extensions (namespaces)
Generic support for all additional extensions (namespaces)
Support for custom user defined extensions (namespaces)

Language support
Full Unicode support allowing any language's character set to be used in feeds
UTF-8 support in feeds for all character sets
In program settable font support

Validation
Automatically validates feeds on open, download, save, and upload
Validation log shows errors, warnings, and automatic repairs
Option to run validation manually

Improved wysiwyg editor
All fields that allow HTML code can now be used with the WYSIWYG HTML editor
Live spell checking
Full support for HTML links
Full support for HTML images (including images as links)

Publishing
Support for multiple destination FTP servers
Automatic image upload option
Automatic enclosure upload option
Option to limit number of items uploaded
Option to upload only current items (no future pubdates)

Feed creation wizard
Walks users through the creation of a standard RSS feed, podcast, or iTunes podcast
Easiest way to start a new feed
Automatically lead into the item creation wizard

Item creation wizard
Walks user through the creation of new feed items
Automatically prompts with fields for the type of feed being added to (i.e. podcast)
Can create multiple new items in single session

Preview
Allows feed to be viewed in a format more typical for subscribers
Multiple template support (for different viewing formats)
Printer support

Stylesheets
Supports both XSL and CSS stylesheet definitions



Introduction 14

© 2004-2006 NotePage, Inc.

1.7 Contact Information

FeedForAll is developed by NotePage, Inc.

Contact Information:

Mailing Address NotePage, Inc.
PO Box 296
Hanover, MA  02339

Email Addresses sales@feedforall.com
support@feedforall.com
Webmaster@feedforall.com

Web Page www.feedforall.com

Support Forum www.feedforall.com/forum

http://www.feedforall.com
http://www.feedforall.com/forum
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2 Installation

2.1 System Requirements

The following are minimal system specifications, needed to run FeedForAll:

Operating System: Windows 2000, XP, 2003, Vista (32-bit)
Processor: Pentium III or faster
Free Memory: 32 Mb
Free Disk Space: 20 Mb
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2.2 Downloaded File

If you have downloaded the FeedForAll program from the Internet (or another source), simply run the file
you downloaded (it will be named 'ffasetup.exe').

Follow the directions in the installation program.
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2.3 CD-Rom

If you computer is configured to 'autorun' CD-ROMs, then the FeedForAll installation program will
automatically start, when you insert the FeedForAll CD-ROM.

If the FeedForAll installation doesn't automatically start, browse to the drive letter of your CD-ROM
(usually D:) and run the program named 'ffasetup.exe'.

Follow the directions in the installation program.
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3 Getting Started

3.1 Quick RSS Primer

RSS stands for Really Simple Syndication or Rich Site Summary (depending on who you ask). RSS is a
defined standard based on XML, with the specific purpose of delivering updates to Web-based content.
Using this standard, Webmasters provide headlines and fresh content in a succinct manner. Meanwhile,
consumers use RSS readers and news aggregators to collect and monitor their favorite feeds from one
centralized program. Content viewed in the RSS reader or news aggregator is known as an RSS feed.
While the majority of RSS feeds currently contain news headlines or breaking information, the long term
uses of RSS are broad.

RSS is becoming increasing popular. The reason is fairly simple. RSS is a free and easy way to promote
a Web site and its content, without the need to advertise or create complicated content sharing
partnerships.

There are three basic parts of an RSS feed.  The feed's general information, the feed's items, and the
feed's image.

The feed's general information is made up of a few required and several optional data fields, which
describe the whole RSS feed.  For example, a feed title, description, and link are required.  Optional feed
fields can contain information about the feed such as the editor, copyright, and Webmaster.

A feed can contain one or more items.  Each item can be thought of as a separate news article or
announcement.  Typically, items are periodically updated by the feed's author, adding new content when
available.  End users who subscribe to (watch) the feed (typically using feed reader or news aggregator
software) are shown the new items when they become available.

Every feed can have an image associated with it.  A feed's image is typically a company logo, or other
image that relates to the feed's content.

After a feed is created, a Webmaster will typically upload it to a Web server, and create links on their
Web site which point to the new feed.  A little effort is also usually spent on advertising the new feed to
visitors (or potential visitors) of the Web site.

RSS feeds are widespread and extensively used by sites such as Yahoo, CNet, NY Times, BBC, and
many more.  Join the club with FeedForAll.  You are in good company.
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3.2 Quick Podcasting Primer

RSS feeds are typically used to broadcast syndicated text content.  Podcasting expands this to include
all kinds of media including videos, audio files, java applets, games or just about any kind of media you
can imagine to computers, cell phones or other enabled devices.  Subscribers can view or listen to the
content any time they want, as opposed to fixed-time syndication technologies such as television or
radio.

Some uses for podcasting are:

· Audio informational content
· Internet 'radio' broadcasting
· Syndicated training videos
· Story telling for children
· Syndicated games such as crossword puzzles that change daily
· Sports casts
· Talk and Music shows

The term 'podcasting came from 'broadcasting to an iPod,' though its uses have greatly expanded since
the term was coined.  Podcasts can be played on computers, mp3 players, cell phones or any device
that is enabled to receive them.

FeedForAll creates podcasts that you upload to your own server or any of a collection of existing
podcast services such as iTunes.  It uses the 'Enclosure' tag to identify the media file to be used for
each item in a podcast.  Podcasting is supported by the RSS 2.0 standard.
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3.3 Feed Creation Wizard

The easiest way to start a new RSS feed in FeedForAll is to use the Feed Creation Wizard.  If you
haven't created and saved a feed yet, FeedForAll will automatically be prompt you to use the Feed
Creation Wizard when the program starts.  You can always choose "Wizard" from the 'Feed' menu to
start a new feed.

The Feed Creation Wizard walks you through entering the information necessary, for creating a new RSS
feed. After you are done entering the required information, you will be prompted to save your new feed.

After you have created a new feed with the Feed Creation Wizard, you will want to upload it to your
server.  Clicking on the upload button in the button bar, or by choosing 'Upload' from the 'Feed' menu.
Please refer to the 'Using FeedForAll' section of this manual for more detailed information about
uploading feeds.
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3.4 The Main Screen

Most of FeedForAll's capabilities are accessible from its main screen.

 

There are six major sections to the main screen:

Main Menu

 
Along the top edge of the FeedForAll screen is the main menu.  Features that aren't accessible from the
button bars can be accessed using the menus.

Tabs

 
Directly under the main menu are three tabs that represent the three major parts of an RSS feed.

On the 'Feeds' tab you switch between feeds you have created, and edit general properties of your feeds.

Add and edit items (news articles) that belong to the current feed on the 'Items' tab.

Add an image to your RSS feed, or edit its existing image on the 'Images' tab

Button Bar

 
Each tab has a button bar.  These button bars contain the most commonly used functions used for each
tab.  For example, when the 'Feeds' tab is active, its button bar contains buttons for creating new feeds,
opening existing feeds, and saving feeds.

List Box
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The 'Feeds' and 'Items' tabs have a listbox on the left hand side.

Use the list box on the 'Feeds' tab to switch between your feeds by clicking on the feed you want to edit.

On the 'Items' tab the list contains all items belonging to the current feed.  Switch between them by
clicking the item you want to work on.

An image display window replaces the list box in the 'Images' tab.

Data Entry Area

 
The right hand side of each tab is occupied by data entry fields.  This is where you can enter the
information that you want in your RSS feed.  There are two or more tabs along the top edge of the data
entry area.  These tabs give you access to additional data entry fields, that belong to the feed.

Status Bar

The status bar at the bottom of the FeedForAll screen shows (from left to right):

· a 'feed modified' indicator
· a insert/overwrite edit state indicator
· a 'current feed' text box
· a 'current time' text box.

An image of a disk will appear in the 'feed modified' indicator area if changes to the current feed have
been made, since the last time it was saved.

The 'current feed' text box shows the full name of the feed that is currently being worked on (including its
path).

The insert/overwrite (ins/ovr) indicator shows how the edit boxes will respond to new text that is typed in.
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The 'current time' text box simply shows the current date and time.
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3.5 Feeds Tab

The 'Feeds' tab is used to edit a feed's primary fields (i.e. title, description, link, etc.), and access to
general feed operations (i.e. new, open, save, upload, etc.).

There are three sections on the 'Feeds' tab: the feed button bar, the 'available feeds' listbox, and the feed
data entry area.

Feed button bar

 
The feed button bar contains buttons for the most commonly used feed operations.  From left to right the
buttons are: New Feed, Open Feed, Save Feed, Close Feed, Download Feed, Upload Feed, Move Feed
Up, Move Feed Down, WYSIWYG Description Editor, View Source, and Preferences. All these functions
(and a few more) are also available from the main menu.

Available feeds list box

 
This list box contains all the feeds that have been worked on in FeedForAll. Click on a feed to make it
the active feed for editing.

Data entry area

 
The data entry area is on the right hand side of the 'Feeds' tab.  There are two tabs in this area:
'Required' and 'Optional'.

The 'Required' tab contains fields that must be filled in for each feed.

· Title: Every feed must have a title.
· Description: You must include a brief description of the feed
· Link: The Web page address containing information about the feed
· Pub Date: The publication date is required so that news readers know when a feed has been
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updated with new items.
· Auto Pub Date: When checked the feed's publication date will be automatically filled in whenever

you add a new item.  The feed's publication date should always match that of its newest item, so it
is recommended that you check Auto PubDate.

The 'Optional' tab contains several additional fields you may choose to include.

· Skip Hours: Set the hours that RSS readers do not have to check for new updates.  If you always
update at midnight, you can tell readers to skip the other 23 hours.

· Skip Days: Tells readers which days to skip checking for new updates.  Use this if you update on
the same day each month.

· Language: Sets the language for your feed.
· Category: Some RSS directories allow users to search for feeds by category.  Set the appropriate

category for your feed here.
· Cloud: Cloud servers let readers know when there are updates to feeds that are registered to them,

thus saving the reader having to check all the time.  If your feed is registered with a cloud server
enter the Domain name or IP address of the server, the port the server runs on, the path (location) of
the cloud server's responder, the name of the procedure that calls the request notification and the
protocol to use to communicate with the cloud server.

· Text input: The Text Input settings allows a data entry box to be displayed within your feed. It can be
used to collect information from the reader, or act on data they enter. Not all feed readers support
this option. If you enter any information for text input you must fill in all four fields to set including the
title, description, variable name assigned to the input box and the link to a CGI program that
receives the data from the data entry box.

· Webmaster: The e-mail address of the person responsible for technical issues relating to the feed
· Editor: An e-mail address for the person responsible for the feed's content
· Copyright: The copyright notification for the feed
· Rating: Optional rating for your feed.  For information on rating a feed, check www.w3.org/PICS.
· Docs: The address of a Web page that explains the RSS specification

· TTL: The 'Time To Live' or the amount of time a feed is allowed to be cached by the server before it
must refresh (look for new items)

The 'Extensions' Tab is used to add extensions (namespaces) to your feed.  For example if you want
your feed to be an iTunes podcast, you would add the iTunes extension to your feed here.  After you add
a new extension you will see that there is a new tab under the Extensions tab for that namespace, for
data entry.  If the namespace supports data in Items or Images, then you will also see new tabs in a
similar location under the Items or Image tab.

The 'Advanced Tab' is used to include XML comments and to support style sheets

· XML Comments: Optional comments about the feed or topics it contains.
· Stylesheet: CSS and XSL Style sheet file names.

Special Features on the Feeds Tab:

Live spell checking

http://www.w3.org/PICS/


Getting Started 26

© 2004-2006 NotePage, Inc.

 
The 'Title' and 'Description' fields are enabled with live spell checking.  Unrecognized words will
automatically be underlined, as you type.  Right-click on any underlined word for spelling suggestions, or
to add it to the dictionary.

WYSIWYG Description HTML editor

 
HTML tags may be included in the description fields in RSS feeds.  This allows some formatting of the
description text, resulting in a more professional looking feed.

Enter HTML tags manually in the 'Description' field, or use the WYSIWYG HTML editor for easier
formatting.  Double-click inside the 'Description' text box, click on the HTML Editor button in the button
bar, or choose 'HTML Editor' from the 'Tools' menu to start the editor.

Pub Date date and time pickers

 
Dates are defined to be in a specific format the RSS specification.  FeedForAll makes entering dates
easy using date and time pickers.  Click on the calendar button to the right of the Pub Date field to
choose a date from a calendar.
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Feed Smart Dates

 
Many RSS feed publishers schedule when their new content is published.  Rather than entering the next
publish date manually each time, the Smart Date button can be programmed to automatically advance
the Pub Date to the next desired publication date.

The Smart Date button (with an image of a calendar with a wand) is to the far right of the Pub Date field.
By default the Smart Date button enters the current date and time into the Pub Date field.  Program the
Smart Date button to enter a more useful date and time in FeedForAll's 'Preferences' screen.

Auto Pub Date

 
There are two types of Pub Dates in an RSS feed: the Feed Pub Date, and Item Pub Dates.

The Feed Pub Date contains the date and time that the most recent item was published.

Each item that is added to a feed also has its own Pub Date that is set to the date and time that the
individual item was published.  The Feed's Pub Date should match the most recent Item's Pub Date.
FeedForAll can automatically handle this for you.  Check the 'Auto Pub Date' box (bottom right corner of
the Feeds tab) to automatically update the Feed's Pub Date.

Help!

 
There are many fields that may be used in an RSS feed.  It may not be obvious from a field's name what
data should be entered into them.  FeedForAll supports a "What's This" help function that can help you
out here.  Click the icon in the top right corner of the Feeds tab and your mouse pointer will change to an
arrow with a question mark.  Click an item in the Feeds tab to display a help window explaining the
purpose of the field.  "What's This" also works on other features of the screen including button bar
buttons.
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3.6 Items Tab

Use the 'Items' tab to access news items that belong to the current feed.

There are three sections on the 'Items' tab: the item button bar, the available items listbox, and the items
data entry area.

Items button bar

 
The items button bar contains buttons for the most commonly used items operations.  From left to right
the buttons are: New Item, Clone Item, Delete Item, Move Item Up, Move Item Down, WYSIWYG
Description Editor, View Source, and Preferences. All these functions (and a few more) are also available
from the main menu.

Available items list box

 
All the items that belonging to the current feed are listed on the left of the Items screen.  Click on an
item in the list to make it active for editing.

Data entry area

 
The data entry areas is on the right hand side of the 'Items' tab.

The 'Required' tab contains fields that must be filled in for each item.

· Title: Each item in a feed must have a unique title.
· Description:  A brief summary of the item is also required.
· Link: Typically readers display the summary along with a 'Read more...' link that takes you to the full

text.  Type the Web location of the full text here.
· Pub Date: The publication date of a new item alerts readers that there is new content in your feed to

download.
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The 'Optional' tab contains several additional fields that you may choose to also include in the current
feed item.

· If you are listed in an RSS directory list the category your item falls in and the domain of the
directory.

· GUID: The Global unique Identifier is a text string that uniquely identifies the item.  Some readers
use it to determine whether the item is new.

· Source: This fields identifies the source of the item if it was obtained from another feed.
· Enclosure: If a file is to be included with this item, it is listed here.
· Author: The e-mail address of the author of the item may be listed here.
· Comments: The URL of a Web page with comments about this item may be specified.

The 'Advanced' tab is where you may enter optional comments about the specific item.

Extensions Tab

If any extension have been chosen for the current feed, the 'Extensions' tab will appear.  Under the
Extensions tab you will be able to enter data for each of the namespace extensions you have chosen to
use.

Advanced Tab

The 'Advanced' tab allows you to enter XML comments for each of your items.  XML comments will exit
in the raw XML code of your feed, but is typically not visible by subscribers.

Special Features on the Items Tab:

Live spell checking

 
The 'Title' and 'Description' fields are enabled with live spell checking.  Unrecognized words will
automatically be underlined, as you type.  You can right-click on any underlined word for spelling
suggestions, or to add it to the dictionary.

WYSIWYG Description HTML editor
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HTML tags can be included in the description fields of RSS feeds.  This allows some formatting of the
description text, resulting in a more professional looking feed.  Enter HTML tags manually in the
'Description' field, or use FeedForAll's WYSIWYG HTML editor that makes this a lot easier.  To start the
editor, double-click inside the 'Description' text box, click on the HTML Editor button in the button bar, or
choose 'HTML Editor' from the 'Tools' menu.

Pub Date date and time pickers

 
Item dates are defined in a specific format the RSS specification.  FeedForAll makes entering dates
easy using date and time pickers.  Click on the calendar button to the right of the Pub Date field to
choose a date from a calendar.

Click on the button to the right of the time to set a new time.

Item Smart Dates

 
Many RSS feed publishers schedule when their new content is published.  Rather than entering the next
publication date manually, the Smart Date button can be programmed to automatically advance the Pub
Date to the next desired publish date.  The Smart Date button is the one to the far right of the Pub Date
field.  It has an image of a calendar with a wand over it.  The default behavior of the Smart Date button is
to enter the current date and time into the Pub Date field.  You can program the Smart Date button to
enter a more useful date and time, in FeedForAll's 'Preferences' screen.
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Help!

 
There are many fields that may be used in an RSS item.  It may not be obvious from a field's name what
data should be entered into them.  FeedForAll supports a "What's This" help function that can help you
out here.  Click the icon in the top right corner of the Feeds tab and your mouse pointer will change to an
arrow with a question mark.  Click an item in the Feeds tab to display a help window explaining the
purpose of the field.  "What's This" also works on other features of the screen including button bar
buttons.
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3.7 Images Tab

Use the 'Images' tab to include an image with your feed.  Although you are not required to include one,
images help you make your feed look more polished and professional.  FeedForAll not only allows you to
setup an image for your feed, but it also allows you to modify the image to improve its appearance.

There are three sections on the 'Images' tab: the image button bar, the image display box, and the image
data entry / editor area.

Image button bar

 
The image button bar contains buttons for the most commonly used image operations.  From left to right
the buttons are: Open Image, Save Image, Re-download Image, Upload Image, View Source, and
Preferences. All these functions (and a few more) are also available from the main menu.

Image display box

 
If the current feed has an image associated with it, then the left side of the 'Images' tab displays it.  If the
image box is blank, either the feed isn't correctly setup to include an image, or FeedForAll is unable to
download the image from the Internet (you may not be connected).

Data entry / editor area

 
The right hand side of the 'Images' tab is occupied by a data entry or editor area.  There are two tabs in
this area: 'Image' and 'Editor'.  The 'Image' tab contains fields that can be filled in to include an image
with your feed.

· Title: The required image title is typically the same as the feed's title.
· Description: Optional 'title' attribute for the image.
· Link: This is the same link as the URL for the feed itself.
· URL: The URL (location) of the image on the Internet is required to display it in readers.
· Width: Optionally you may enter the image's width in pixels.
· Height: You may optionally enter the image's height in pixels.

Advanced Tab
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The 'Advanced' tab allows you to enter XML comments to the Image section of your feed.  XML
comments will exit in the raw XML code of your feed, but is typically not visible by subscribers.

Special Features on the Images Tab - There are a few program features available on the 'Images' tab
that you should be aware of:

Image Zoom - Your feed's image may not fully fit in the image box provided.  By clicking on the image
you can toggle between the regular sized image box, and a much larger version.

The 'Editor' tab is for manipulating an existing image.

Image Resizing: Use the 'Resize' tab to resize the image to a size that displays well in feed readers.
The default image size for an RSS feed is 88 pixels wide, by 31 pixels high.  The maximum allowed
image size is 144 pixels wide, by 400 pixels high.

Image Rotating: If the image you want to use for your feed isn't angled as you want it, FeedForAll can
rotate it for you.

Flip Image: Sometimes the mirrored version of an image looks better in an RSS feed.  Use the 'Flip' tab
to flip your image horizontally or vertically.

Crop Image: RSS images are relatively small due to the size constraints in the specification.  Cropping
extra space off the outside edges of an image can help a large image fit better.

The 'Advanced' tab provides a space to enter optional comments about your image.

Help!

 
There are many fields that may be used in an RSS feed.  It may not be obvious from a field's name what
data should be entered into them.  FeedForAll supports a "What's This" help function that can help you
out here.  Click the icon in the top right corner of the Feeds tab and your mouse pointer will change to an
arrow with a question mark.  Click an item in the Feeds tab to display a help window explaining the
purpose of the field.  "What's This" also works on other features of the screen including button bar
buttons.
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3.8 Extensions (namespaces)

RSS has a defined mechanism that allows it to be extended, for new purposes and uses.  This basically
allows organizations to define a set of new fields that can be used in RSS feeds.  These 'groups of new
fields' are defined as a namespace and can be used for an extension of RSS.  For the sake of simplicity,
we will simply call these sets of newly defined fields 'Extensions'.  There are several well know RSS
extensions in use and although FeedForAll supports the use of any and all extensions, there is an
enhanced level of support for the most common extensions (iTunes, Dublin Core, Content, and
Syndication).

To add an extension to your feed, simply make the 'Feed' tab current and then click on the 'Extensions'
tab.  You will see a list of the extensions that your copy of FeedForAll already know about.  You can add
a new extension to the list by clicking the 'Add New Extension to List' button.  But, if the extension your
are interested in using is already in the list, you simply need to check the box next to it.

Whenever you open a new feed that has an extension that FeedForAll doesn't know about, it will
automatically add the new extension's definition to its list.  In this way FeedForAll can actually 'learn'
about new extensions without you even needing to manually define them.

After adding an extension to your feed, you will see a new tab under the Extensions tab for that new
extension.  For example, if you choose to add the iTunes extension to your feed, you will see a new tab
labeled 'iTunes' under the Extensions tab for the Feed, and for each Item in the feed.
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3.9 Tips, Tricks, Shortcuts

Tips:

· If you have several feeds with the same name, but are kept in different folders, it may be easier to tell
them apart in the Feeds list box if you set FeedForAll to display the full path along with the file name
there.  This option is found under the 'Display' tab on the Preferences screen.

· Power users who prefer speed over looks may turn off FeedForAll's skin feature.  It isn't pretty, but is
fast.  This option can be found under the 'Display' tab on the Preferences screen.

· If you enjoy a customized interface, registering FeedForAll adds over 50 additional skins available for
you to download and install.

· Don't use English in your feeds?  There are two things you should know that can help.  First, additional
spell checking dictionaries are available for download from our Web site.  Second, in the WYSIWYG
HTML Description Editor, there is an option to insert symbols into the text.  These aren't as much
symbols, as they are additional characters that can be inserted (i.e. accented characters)

Keyboard Shortcuts:

Create a new Feed or Item
(depending on which tab is active)

<ctrl><enter>

Delete current Feed or Item
(depending on which tab is active)

<ctrl><del>

Save current Feed <ctrl> s

Upload current Feed <ctrl> u

Find & Find/Replace dialog <ctrl> f

Mouse Shortcuts:

WYSIWYG Description HTML Editor Double-click in the description field

Field Edit Menu Right-click on any field

Variable Menus:
Some fields that you right-click in will have different options in their right-click menus.  For example, on
the Image tab the 'Title' field typically will be set to the same text as the 'Title' field on the 'Feed' tab.  If
you right-click in the Image's Title field, you will see the option 'Paste from Feed Title'.



Getting Started 36

© 2004-2006 NotePage, Inc.

3.10 Where to Get Help

Several resources are available to help you use FeedForAll.

Web site - Our Web site (www.feedforall.com) contains a wealth of information about the FeedForAll
product.  It is a good place to start when looking for information about FeedForAll or RSS feeds.  Other
RSS specific Web sites can also be a big help (i.e. www.rss-faq.com).

Documentation - The FeedForAll manual can be obtained in several formats.  The manual included in
the product download is in a standard Windows help file format.  There is an online version of the manual
available in the support section of our Web site.  At the same location you will find several downloadable
versions of the manual including: pdf, winhelp, and htmlhelp.

Tech Support - The best place to get technical support for FeedForAll is in our tech support forum
(www.feedforall.com/forum).  You can also send technical support issues to our support email
address(support@feedforall.com).

RSS Informational Resources - If you are new to RSS, or want to learn more about advanced RSS
topics, then an excellent resource is our Educational Article Archive found at:
http://www.feedforall.com/newsletter.htm.  If you have questions about RSS, then this is the place to
look.

http://www.feedforall.com
http://www.rss-faq.com
http://www.feedforall.com/forum
http://www.feedforall.com/newsletter.htm
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4 Using FeedForAll

4.1 Feeds

4.1.1 Manually Create a Feed

Click the 'New Feed' button in the Feed tab's button bar, choose 'New' from the 'Feed' menu, or hit
<ctrl><enter> while the 'Feeds' tab is active to create a new blank feed.

Fill in all the required fields on the 'Feeds' tab, then create at least one new item on the 'Items' tab.

Save your new feed by clicking 'Save As' from the 'Feed' menu.

4.1.2 Create Feed With Wizard

The first time you run FeedForAll you will be asked if you want to use the Feed Wizard to create a new
feed.  The Feed Wizard can also be started any time after that by choosing 'Wizard' from the 'Feed'
menu.

The wizard will walk through all the necessary steps to create a working RSS feed, podcast, or iTunes
podcast.  When the feed section of the wizard is complete it will automatically lead you into the Item
Wizard, which will assist you in creating items for your feed.  You can choose to skip item creation and
end the wizard at the conclusion of the feed creation part.

When the Feed Wizard is complete, you will be prompted to save your new feed to disk.  The Feed
Wizard only guides you through the required fields for your feed to be functional.  There are many
additional fields you can add to your feed.  The new feed and items can be edited using FeedForAll's
main screens.

4.1.3 Opening an Existing Feed

There are two ways to load an existing RSS feed into FeedForAll:

Download an Existing Feed from the Internet

Click on the 'Download Feed' button in the Feeds tab's button bar, or choose 'Download' from the 'Feed'
menu.  When the screen appears, enter the URL for the existing RSS feed (the 'http://' prefix is optional).
After downloading a feed from the Internet, save a copy onto your hard drive.  This is accomplished by
hitting the 'Save Feed' button, or by choosing 'Save' from the 'Feed' menu.

Opening an Existing Feed from your Local Disk Drive

Click on the 'Open Feed' button in the Feed tab's button bar, or by choose 'Open' from the 'Feed' menu.
When the screen appears, you can either browse to the existing feed's file, or type it into the file name
box.

4.1.4 Modifying a Feed

Modify an existing feed by simply changing the values in the feed's fields.  Once the changes have been
made, save the updated feed and upload it to your Web server.
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4.1.5 Saving a Feed

If your feed was opened from your hard disk, or was previously saved, click the 'Save Feed' button or the
'Save' menu item (under the Feed menu) to save it to the same location.  The 'feed modified' indicator
icon in FeedForAll's status bar will disappear.

If the feed is being saved locally for the first time, a 'Save File' dialog window appears, allowing you to
name the feed's file, and browse to a location to save it to.

If the feed has already been saved, but you want to save it to a different file name or location, then
choose the 'Save As' option from the 'Feed' menu.

To 'save' your feed to a Web site (Web server), please refer to the 'Uploading a Feed' topic.

4.1.6 Uploading (Publishing) a Feed

Use FeedForAll to publish your feed on a Web server so that users can access it.  Access the 'Publish'
screen by clicking on the 'Publish' button in the Feed tab's button bar, or choosing the 'Publish' option
from the 'Feed' menu.

The Publishing function uses the FTP protocol to upload you feed to a webserver.  You also have the
option to upload the feed's image, and any enclosures you have setup for your items, all in one step.

The first time you use the Publish screen, the 'Site' list will be empty.  Click the 'Edit' button to create a
new FTP site to upload you feed to.
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On the Upload Site Maintenance screen you can create new FTP sites to upload to, edit existing sites,
and test connectivity to each site.

· Site Name: a text description your give the site
· Server Address: the address of the webserver or FTP server on the Internet
· Server Type: the type of FTP server you will be connecting to

· Username: the username or account name you have on the FTP server
· Password: the corresponding password for the username

· Feed Path: the location where you want your feed file stored on the FTP server (relative the default
folder you are placed in when you log in to the FTP server)

· Browse: the folder icon to the right of the Feed Path will allow you to browse to the appropriate folder
on the FTP server (highly recommended)

· Image Path: the location where you want your feed's image file stored on the FTP server (relative the
default folder you are placed in when you log in to the FTP server)

· Browse: the folder icon to the right of the Image Path will allow you to browse to the appropriate folder
on the FTP server (highly recommended)

· Enclosures Path: the location where you want the enclosures you have defined for each item in your
feed (relative the default folder you are placed in when you log in to the FTP server)

· Browse: the folder icon to the right of the Enclosures Path will allow you to browse to the appropriate
folder on the FTP server (highly recommended)

· Test Settings: This will make a test connection to the FTP server to be sure the Server Address,
Username, and Password are correct.

· View Test Log: If the test connection isn't successful, then this is the first place to look for reasons.

Once you have entered the correct information and tested the settings, click on the Apply button (the
checkmark) to save your new site.  Feel free to setup multiple FTP sites at this time, if you will be
uploading your feeds to multiple servers.

Once you have a site created, you can now choose some options back on the Publish screen.
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· Site: choose the FTP server you want to upload your feed to.
· Edit: edit the settings for the existing FTP site, or create a new site.
· Username: the username entered when the site was created
· Password: the password entered when the site was created, or if it was left blank, the password can

be manually entered at the time of each upload

· Upload Feed File (XML): indicates that you want your feed file uploaded during this publishing session
(this would be checked in almost all cases)
· Filename: the name you want to give to your feed file when it is uploaded.
· Limit number of items to: allows you to limit how many of your items you want uploaded at this time

(leave blank to upload all items)
· Skip items with future Pub Dates: will not upload items in your feed that you have purposely set to

have future Pub Dates

· Upload Feed Image: indicates that you want to upload an image that you have set for your feed to use.
· Filename: the name you want to give to the image file when it is uploaded

· Upload Enclosures: indicates that you want some (or all) of the enclosures you have associated with
your items to also be uploaded, along with the feed file.
· Upload: check each enclosure you want uploaded at this time.

· Publish: starts the publishing process
· View Log: show a log of the communications with the FTP server.
· Done: close the Publishing window.

4.1.7 Removing a Feed

Click the "Remove Feed' button to remove a feed from the list in the Feed tab, choose 'Remove' from the
'Feed' menu, or hit <ctrl><del> when the 'Feeds' tab is active.

When you remove a feed, it is simply removed from the list.  The feed's file is NOT deleted from your hard
drive, or your Web site.

4.1.8 Rearranging Feed Order

The order in which the feeds show up in the feeds list box, can be changed by highlighting the feed you
want to move, and then click the 'Move Up' and 'Move Down' buttons in the Feed tab's button bar, or
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choose 'Move Feed Up' and 'Move Feed Down' from the 'View' menu.



Using FeedForAll 42

© 2004-2006 NotePage, Inc.

4.2 Items

4.2.1 Creating a New Item

Click on the 'New Item' button in the Item tab's button bar, choose 'New' from the 'Item' menu, or hit
<ctrl><enter> while the Items tab is active to create a new item in your RSS feed.  New Items are
always added to the top of the Items list box (the same order in which most feed readers will display
them).

4.2.2 Create Item with Wizard

The Item Creation Wizard can walk you through entering all the required data necessary for creating a
new item for your feed.  It is capable of creating multiple items in one session, and is the easiest way to
add new items to your feed.  Any item that is created with the wizard can then be manually edited after
the wizard is done.

4.2.3 Modifying an Existing Item

Modify the current item by simply changing the values in its fields. FeedForAll remembers your changes
so that switching items doesn't undo them.  Once the desired changes have been made, save the
updated feed and then upload it to your Web server.

4.2.4 Cloning an Item

Sometimes it is easier to start with a copy of an existing item and modify it, instead of creating a new
item from scratch. This is especially true if you have a lot of data in the optional item fields, that will be
similar (you can also refer to the 'Preferences' section of this manual for information about setting default
values for the fields in new items).

Highlight the item you want to clone and then click the 'Clone Item' button in the Item tab's button bar, or
choose 'Clone' from the 'Item' menu.

4.2.5 Deleting an Item

To delete an item from your feed highlight it in the Items list box and click the 'Delete Item' button in the
Item tab's button bar, choose 'Delete' from the Item menu, or hit <ctrl><del> while the Item tab is active.

WARNING: Deleting an item permanently removes it from your feed, once the feed is saved to disk or
uploaded to your Web server.

4.2.6 Rearranging Item Order

Normally items in a feed are displayed chronologically, with the newest items at the top.  FeedForAll can
change the order if you want to override the default ordering.

Highlight the item you want to move, and then use the 'Move Up' and 'Move Down' buttons in the Item
tab's button bar, or choose 'Move Item Up' and 'Move Item Down' from the 'View' menu.
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4.3 Images

4.3.1 Including an Image in a Feed

Adding an image to your RSS feed can make it look more professional. As defined in the RSS
specification, feed images are relatively small.  The maximum allowed width is 144 pixels and the
maximum height is 400 pixels.  Typically icons, logos, or other small images are used for RSS feed
images.

RSS feed images are not included inside an RSS feed's file.  An RSS feed's image is a separate image
file that is pointed to by your feed. An RSS feed reader will download your feed, and then download the
image your feed points to. If you use FeedForAll to load an image from disk, or to modify an existing
feed's image, you will need to upload it along with your feed to your Web site.

Only .gif, .jpg, and .png image file formats are allowed by the RSS specification.

Link vs URL:

One common question is 'What is the difference between the Link field and the URL field on the Images
tab?'  The Link field is the Web address of a Web page that has information that relates to this feed.  It is
the location the user is taken to when clicking on the link.  In most cases the Link field should be the
same as the Link field on the Feeds tab.

The URL field is the Web address of the image file itself.
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4.4 Validation

4.4.1 Validating Feeds

FeedForAll has a feed validation function built in.  It will automatically attempt to validate any feed that
you open, and will again attempt to validate you feed when you save or publish it.  If there are no
validation errors, warnings, or automatic repairs, the validation log screen won't even show up.
Otherwise, you will be presented with the Validation Log screen, showing the problems with the feed.  In
the Miscellaneous section of Preferences you can change when the Validation Log screen will appear.

To manually start the validation function, click the 'Validate Feed' button in the toolbar, or choose
'Validate' from the 'Tools' menu.  When the Validation Log is showing you can click on any of the errors,
warnings or repairs, and you will be brought to the relevant field on FeedForAll's main screen.
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4.5 Preview

4.5.1 Previewing Feeds

The Preview function can be accessed by clicking on the 'Preview Feed' button on the toolbar, or by
choosing 'Preview/Print' item from the 'Feed' menu.

Previewing a feed allows you to get an idea of what the feed may look like to your subscribers.
Templates can be used to preview the feed to help get an idea of what it will look like in different viewers.
For example the 'ItunesPreview.htm' template will show what your feed items will look like in the iTunes
store.  There are several preview templates available in the 'Templates' folder under the FeedForAll
program folder, or you can make your own.  The templates are simply HTML webpage templates, similar
to the ones used in our free RSS2HTML script.
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4.6 Publishing (Uploading)

4.6.1 Overview

Publishing your feed means putting a copy of your feed on a webserver so it is available for others to
access, subscribe, download, etc.

If you webserver is on your local network, then it might be as easy as saving your feed file to the proper
shared folder.  However, for most people publishing will mean uploading your feed file to a webserver
using FTP (file transfer protocol).

In order to upload you feed to your webserver you will need a few pieces of information to start with:

1. The web address of the FTP server (many times the same address as your webserver)
2. The username needed to log into the FTP server
3. The password needed to log into the FTP server
4. The location on the server where the RSS feed file should go.

4.6.2 Steps

Use FeedForAll to publish your feed on a Web server so that users can access it.  Access the 'Publish'
screen by clicking on the 'Publish' button in the Feed tab's button bar, or choosing the 'Publish' option
from the 'Feed' menu.

The Publishing function uses the FTP protocol to upload you feed to a webserver.  You also have the
option to upload the feed's image, and any enclosures you have setup for your items, all in one step.

The first time you use the Publish screen, the 'Site' list will be empty.  Click the 'Edit' button to create a
new FTP site to upload you feed to.
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On the Upload Site Maintenance screen you can create new FTP sites to upload to, edit existing sites,
and test connectivity to each site.

· Site Name: a text description your give the site
· Server Address: the address of the webserver or FTP server on the Internet
· Server Type: the type of FTP server you will be connecting to

· Username: the username or account name you have on the FTP server
· Password: the corresponding password for the username

· Feed Path: the location where you want your feed file stored on the FTP server (relative the default
folder you are placed in when you log in to the FTP server)

· Browse: the folder icon to the right of the Feed Path will allow you to browse to the appropriate folder
on the FTP server (highly recommended)

· Image Path: the location where you want your feed's image file stored on the FTP server (relative the
default folder you are placed in when you log in to the FTP server)

· Browse: the folder icon to the right of the Image Path will allow you to browse to the appropriate folder
on the FTP server (highly recommended)

· Enclosures Path: the location where you want the enclosures you have defined for each item in your
feed (relative the default folder you are placed in when you log in to the FTP server)

· Browse: the folder icon to the right of the Enclosures Path will allow you to browse to the appropriate
folder on the FTP server (highly recommended)

· Test Settings: This will make a test connection to the FTP server to be sure the Server Address,
Username, and Password are correct.

· View Test Log: If the test connection isn't successful, then this is the first place to look for reasons.

Once you have entered the correct information and tested the settings, click on the Apply button (the
checkmark) to save your new site.  Feel free to setup multiple FTP sites at this time, if you will be
uploading your feeds to multiple servers.

Once you have a site created, you can now choose some options back on the Publish screen.
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· Site: choose the FTP server you want to upload your feed to.
· Edit: edit the settings for the existing FTP site, or create a new site.
· Username: the username entered when the site was created
· Password: the password entered when the site was created, or if it was left blank, the password can

be manually entered at the time of each upload

· Upload Feed File (XML): indicates that you want your feed file uploaded during this publishing session
(this would be checked in almost all cases)
· Filename: the name you want to give to your feed file when it is uploaded.
· Limit number of items to: allows you to limit how many of your items you want uploaded at this time

(leave blank to upload all items)
· Skip items with future Pub Dates: will not upload items in your feed that you have purposely set to

have future Pub Dates

· Upload Feed Image: indicates that you want to upload an image that you have set for your feed to use.
· Filename: the name you want to give to the image file when it is uploaded

· Upload Enclosures: indicates that you want some (or all) of the enclosures you have associated with
your items to also be uploaded, along with the feed file.
· Upload: check each enclosure you want uploaded at this time.

· Publish: starts the publishing process
· View Log: show a log of the communications with the FTP server.
· Done: close the Publishing window.

4.6.3 Troubleshooting

Here are the most common reasons for an upload to fail:

1. The FTP server address is incorrect
2. The username is incorrect
3. The password is incorrect
4. The path you are trying to upload the file to does not exist
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The first three can be easily remedied by contacting you web hosting provider and verifying your server
and login information.

The fourth reason is actually quite common.  When you connect to a webserver via FTP, you are placed
into a default folder that has been assigned to your username by your web hosting provider.  This folder
may not be the main folder for your webpages, and it also probably isn't the root folder on the webserver.
If you think you have a path problem, the best way to check is to look at the FTP log in FeedForAll.
When FeedForAll connects to your FTP server, it will log all the sub folders under the default folder after
login.  In addition FeedForAll will log all the sub folders each time it changes into another folder.

When you are setting up a new site for FeedForAll to use, be sure to use the 'Test Settings' and the
'View Test Log" buttons to verify that your settings are correct.
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4.7 Search and Replace

4.7.1 Finding and Replacing Text

FeedForAll has an advanced search and replace feature that is useful for making global updates to a
feed.  For example, if your Web site layout changes use search and replace to update your feed to the
new link addresses. To access the 'Search' window, choose 'Search' from the 'Edit' menu.

Use the 'Search In' section to only perform the search in a particular tab, or in all sections of your feed.

Use the 'Freeze Dates' option to make replacements, without the Pub Dates being automatically
updated.
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4.8 WYSIWYG HTML Editor

4.8.1 Using HTML in Description Fields

The RSS specification allows the use of HTML tags in the description fields.  In the past, HTML tags
would need to be manually added to the description text.  FeedForAll includes a WYSIWYG HTML
Editor for the description fields.  Add color, change font styles, and even add links to your feed's
description fields.

To access the WYSIWYG HTML Editor, double-click anywhere in the description text box.  You can
also start the editor by clicking on the 'Edit Description HTML' button in the Feed's or Item's button bar,
or choose 'HTML Editor' from the 'Tools' menu.
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4.9 Exporting

4.9.1 Overview

FeedForAll includes a powerful, yet easy to use export feature.

Some reasons you may want to export your RSS feed:

· Create a Web page that displays your feed's contents *
· Create a HTML table to include inside an existing Web page
· Save the feed's data into a format that can be imported by a blogging program
· Save the feed's data into a file that can read into a database program
· Save the feed's data to a file that can be opened in a word processor
· Save the feed's data so it can be opened by a spreadsheet program

FeedForAll uses templates in the creation of its export files.  The templates allow you to customize the
format of the exported file.

* Also see Getting Your Feed on the Web to see how to create a dynamic web page that automatically
updates as your feed changes.

4.9.2 Creating Templates

Export Templates

Export templates are simply text files that define the format that the feed will be exported into.
Templates may contain several variables that are automatically filled in when the feed is exported.  For
example a template could be a full html Web page, with variables in the places you want the feed's data
to be inserted.  Here is an example of a simple HTML template file:

<HTML>
    <HEAD>
        <TITLE>~~~FeedTitle~~~</TITLE>
    </HEAD>
    <BODY>
        <H1>~~~FeedTitle~~~</H1>
        <H2>~~~FeedDescription~~~</H2>
        <BR>
        <TABLE width="100%">
            ~~~BeginItemsRecord~~~
            <TR><B>~~~ItemTitle~~~</B></TR>
            <TR>~~~ItemDescription~~~</TR>
            <BR>
            ~~~EndItemsRecord~~~
        </TABLE>
    </BODY>
</HTML>

Each variable name is surrounded by three tildes (~~~) so that it isn't mistaken for regular text.  When a
feed is exported using this template, each variable is replaced with the actual feed's data.

Two special variable names act as markers.  They are '~~~BeginItemsRecord~~~" and
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'~~~EndItemsRecord~~~".  Everything in between these two variables will be duplicated for each item in
the feed.  So, for example, if your feed has 5 items in it, everything between these two variables will be
repeated 5 times.  Each time the next item's information will be used in the variables found in the
duplicated section.

This is what the output of this template would look like for a sample feed with three items in it:

<HTML>
    <HEAD>
        <TITLE>FeedForAll Sample Feed</TITLE>
    </HEAD>
    <BODY>
        <H1>FeedForAll Sample Feed</H1>
        <H2>RSS is a fascinating technology. The uses for RSS are expanding daily.</H2>
        <BR>
        <TABLE width="100%">
            <TR><B>RSS Solutions for Restaurants</B></TR>
            <TR>FeedForAll helps Restaurant's communicate with customers. Let your customers know the
latest specials or events</TR>
            <BR>
            <TR><B>RSS Solutions for Schools and Colleges</B></TR>
            <TR>FeedForAll helps Educational Institutions communicate with students about school wide
activities, events, and schedules.</TR>
            <BR>
            <TR><B>RSS Solutions for Computer Service Companies</B></TR>
            <TR>FeedForAll helps Computer Service Companies communicate with clients about cyber
security and related issues.</TR>
            <BR>
        </TABLE>
    </BODY>
</HTML>

When viewed in a Web browser the output will look something like this:

FeedForAll Sample Feed

RSS is a fascinating technology. The uses for RSS are expanding daily. Take a
closer look at how various industries are using the benefits of RSS in their
businesses.

RSS Solutions for Restaurants
FeedForAll helps Restaurant's communicate with customers. Let your customers know the latest
specials or events.

RSS Solutions for Schools and Colleges
FeedForAll helps Educational Institutions communicate with students about school wide activities,
events, and schedules.

RSS Solutions for Computer Service Companies
FeedForAll helps Computer Service Companies communicate with clients about cyber security and
related issues.
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Here are the variables available for use in FeedForAll export templates:

~~~FeedTitle~~~
~~~FeedDescription~~~
~~~FeedLink~~~
~~~FeedPubDate~~~
~~~FeedPubLongDate~~~
~~~FeedPubShortDate~~~
~~~FeedPubLongTime~~~
~~~FeedPubShortTime~~~
~~~ItemTitle~~~
~~~ItemDescription~~~
~~~ItemLink~~~
~~~ItemPubDate~~~
~~~ItemPubLongDate~~~
~~~ItemPubShortDate~~~
~~~ItemPubLongTime~~~
~~~ItemPubShortTime~~~

~~~BeginItemsRecord~~~
~~~EndItemsRecord~~~

4.9.3 HTML (webpages)

Exporting feeds to html files is useful for displaying your feed:

· Set up your Web page as a template, and export the feed's data into it.
· Create a template that just creates an html table containing the feed.  The table is then included inside

an existing Web page on your Web site by using a server-side include, or some simple javascript.

Choose 'Export' from the 'Tools' menu.

First choose the template you want to use.  Choose one of the included sample templates or use one of
your own.

Next supply a file name and location for the file that FeedForAll will create.  Be careful not to use the
same file name and path as an existing template file, because it will be overwritten.  Begin the export by
clicking on the 'Export' button or the check-mark button in the button bar.

4.9.4 JavaScript

Exporting to JavaScript creates a file you may use as a Server Side Include file in an existing web page.
When set up in this way the feed data changes while the surrounding page remains the same.

Choose 'Export' from the 'Tools' menu.

First choose the template you want to use.  Choose one of the included sample templates or use one of
your own.

Next supply a file name and location for the file that FeedForAll will create.  Be careful not to use the
same file name and path as an existing template file, because it will be overwritten.  Begin the export by
clicking on the 'Export' button or the check-mark button in the button bar.
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4.9.5 Text

You may want to export the contents of your feed to a regular text file.  This will enable you to open your
feed in other programs like text editors and word processors.  Exporting to a text file is a simple way to
get your data into e-mail or a newsletter.

Choose 'Export' from the 'Tools' menu.

First choose a template to use.  You may choose one of the included sample templates or use one of
your own.

Next supply a file name and location for the file that FeedForAll will create.  Be careful not to use the
same file name and path as an existing template file, because it will be overwritten.  Click  the 'Export'
button, or the check-mark button in the button bar to begin your export.

4.9.6 CSV (comma separated values)

CSV (comma separated values) is a standard text format that can be read by may different programs.
Most database, spreadsheet and many other programs read or import CSV files.

Choose 'Export' from the 'Tools' menu.

First choose a template to use.  You may choose one of the included sample templates or use one of
your own.

Next supply a file name and location for the file that FeedForAll will create.  Be careful not to use the
same file name and path as an existing template file, because it will be overwritten.  Click  the 'Export'
button, or the check-mark button in the button bar to begin your export.
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4.10 Skins

4.10.1 Changing Skins

Customize FeedForAll's user interface by selecting one of many skins.  Users find that visual pleasing
user interface can improve productivity. Different color combinations are easier on the eyes for different
people.  Ten skins are supplied with the evaluation version of FeedForAll.  When you register FeedForAll,
you may choose to download over 50 additional skins.

Choose 'Skin' from the 'Tools' menu.  Click on the name of a skin to preview it.  When you find a skin you
like either double-click on the skin's name in the listbox, or click the 'OK' button.

The default skin that FeedForAll uses when it is first installed is named 'Default'.

4.10.2 Downloading Additional Skins

Over 50 additional skins are made available to registered users of FeedForAll.  Details for downloading
the additional skins are included in the email that contains your FeedForAll registration key.

4.10.3 Disabling Skins

If you prefer speed to looks disable FeedForAll's skins choose the 'Display' tab on the 'Preferences'
screen.  Check the 'Disable Skins' box.
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4.11 Source Viewer

4.11.1 Using the Source Viewer

There are times when you may want to view or edit the actual XML source that makes up your RSS feed.
For example, if you try to open an existing RSS feed that is so badly formatted that FeedForAll can't
automatically repair it, you are given the option of manually fixing the problem in the Source Viewer
window.

Access the source viewer by clicking on the 'View Source XML' button in the button bar, or by choosing
'Source' from the 'View' menu.

The RSS XML Source window has two tabs:

Source:
The 'Source' tab shows the current feed's XML code in its current form.  This is what will be saved or
uploaded.

The 'Source' view is colorized and formatted to make it easier to read.  This formatting is not saved as
part of the XML file.  If you would prefer to view the XML source in a plain text version, choose 'Plain' from
the 'View' menu.  If you make manual changes to the XML code, Choose 'Reformat' from the 'View' menu
to make it easier to read.

Original:
The 'Original' tab shows a copy of the XML source exactly as it was read into FeedForAll.  This view
does not contain any of your changes, or any repairs that FeedForAll may have made.

If you have made changes to the XML source code, but decide not to keep your changes, reload the
unchanged XML source code by clicking on the 'Reload Source' button in the button bar, or by choosing
'Reload' from the 'File' menu, or simply close the Source Viewer without saving your changes.

To save your changes to the feed's XML source code and return to the main screen, click  the 'Save and
Close' button in the button bar, or choose 'Save' from the 'File' menu.

You can also print your feed's XML source code by choosing 'Print' from the Source Viewer's 'File' menu.
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4.12 Preferences

4.12.1 Overview

The Preferences screen is used to set up default values for newly created feeds and items, programming
the Smart Date buttons, configuring spell checking options, and changing the way some objects are
displayed in FeedForAll. The Preferences screen can be accessed by clicking on the 'Preferences'
button in the button bar, or by choosing 'Preferences' from the 'Tools' menu.

4.12.2 Field Defaults

4.12.2.1 Overview

The 'Field Defaults' tab on the Preference screen allows you to set default values that will be
automatically inserted into the fields of new feeds, and items.  You can also program the Smart Date
buttons under this section.

4.12.2.2 Current Feed

4.12.2.2.1  Item Fields

Values entered into these fields will be automatically added to each new Item that you create in the
current feed.  Values entered on this tab will override any values setup for the same field, under the 'All
Feeds' tab.

4.12.2.2.2  Smart Date

Many RSS feed publishers have a scheduled for when their new content is published (made available to
their audience).  Rather than entering the next publish date manually each time, the Smart Date button
is programmed to automatically advance the Pub Date to the next desired publication date.

The default behavior of the Smart Date button is to enter the current date and time into the Pub Date
field.  Use this tab to program the Smart Date button to enter a more useful date and time.  Changes
made to the Smart Date settings on this tab will only be used for the current feed.

Smart Date settings made on this tab will override settings made under the 'All Feeds' tab.

4.12.2.3 All Feeds

4.12.2.3.1  Feed Fields

Values entered into these fields are automatically added to each new feed that you create.

4.12.2.3.2  Item Fields

Values entered into these fields are automatically added to each new Item that you create in any feed.  If
there is a corresponding value setup for a field under the 'Current Feed' tab, that value will override the
value set on this screen.

4.12.2.3.3  Smart Date

Many RSS feed publishers have a scheduled for when their new content is published (made available to
their audience).  Rather than entering the next publish date manually each time, the Smart Date button
is programmed to automatically advance the Pub Date to the next desired publish date.
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The default behavior of the Smart Date button is to enter the current date and time into the Pub Date
field.  Use this tab to program the Smart Date button to enter a more useful date and time.  Any changes
to the Smart Date settings made on this tab will be used for all feeds.

Smart Date settings made under the 'Current Feed' tab will override settings made here.

4.12.3 Spell Checking

By default, FeedForAll uses live spell checking for the Title and Description fields.  The way spell
checking works can be configured by choosing the 'Spell Checking' tab on the Preferences screen.

You can disable spell checking by clearing the 'Enable spell checking' box.

FeedForAll's download includes an American dictionary only.  Additional language dictionaries are
available for download from our Web site here: www.feedforall.com/dictionaries.htm.  After the additional
dictionaries are installed, the drop-down list box labeled 'Main dictionary' will include the new dictionary.

4.12.4 Miscellaneous

Program Font: pick a font you want used in FeedForAll with the 'Program Font' drop-down list.  This font
is only used in the program display and does not affect your actual feeds.

Validation Results: choose when the validation screen should show itself.

Disable Skins: Turn off FeedForAll's skin feature.  This results in a simple, but speedy interface.

Hide paths in feeds list: If you clear this checkbox, FeedForAll displays the full path and file name for
each feed that is listed in the Feeds list box on the main screen.

Add <br /> on <Enter> in Description fields: Sets whether you want an HTML break tag added each time
you hit enter in one of the feed's description fields.

http://www.feedforall.com/dictionaries.htm
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5 What's Next?

5.1 After you have created your feed

Transfer the Feed Onto Your Server
Once you have constructed an RSS feed you will need to transfer the feed to your server. This can be
done using a standard FTP client (if it is not built into the feed creation software). The feed is usually
placed in the domain's root directory like this: http://www.mydomain.com/nameoffeed.xml , but as long
as you know where it is it doesn't really matter.

Display the Feed on Your Website Using a Graphic of Some Sort
In order to signal to website visitors that an RSS feed containing content related to the website is
available, include a colorful graphic on the website. It has become a standard that nearly all websites
that have RSS feeds available use colorful graphics such as flags as indicators that RSS feeds are
available for specific content. The flags were initially bright orange rectangles but as the popularity has
grown, webmasters have bent the rules a bit. NotePage has made a free online RSS graphic tool
available that allows users to quickly customize buttons by selecting the text on the button and the color
scheme of the button. Once the color and text is entered, a custom graphic is instantly created.
Webmasters can easily match the style of the RSS button to a website's theme. Graphics experience is
not required. Simply select alternative colors and insert text to personalize RSS feed graphics. The RSS
graphics tool can be used by clicking the following URL http://www.feedforall.com/public/rss-graphic-
tool.htm or choose ready made graphics from: http://www.rss-specifications.com/rss-graphics.htm .

Include Information in the HTML of the Web Page So RSS Readers Auto-Detect Your Feed
After publishing an RSS feed it is important to let visitors know that the feed exists. Aggregators will
automatically detect RSS on a website if you add a small bit of code in the header field of an HTML
page.

[link rel="alternate" type="application/rss+xml" title="RSS" href="http://www.yourdomain.com/rss.xml"]

Be sure to replace http://www.yourdomain.com/rss.xml with the URL to the RSS feed and replace the
brackets with "<" less than and ">" greater than symbols.

An easy way to create the correct autodiscovery code is to use our free online tool:
http://www.feedforall.com/autodiscovery.htm

Display the Feed's Content on a Website
Contents contained in an RSS feed can be added to a website, providing site visitors an alternative
method for viewing the content. The information will also help increase search engine interest. Displaying
the feed as HTML can be accomplished. Providing fresh content on a regular basis will encourage site
visitors return.

Tutorial for Displaying Feeds - http://www.small-business-software.net/display-rss.htm

Submit the Feed to RSS Directories and Search Engines
As a rapidly increasing number of content sources, new and old, migrate or add RSS as a key
distribution channel, and as more people utilize RSS newsreaders and aggregators to keep themselves

http://www.feedforall.com/public/rss-graphic-tool.htm
http://www.rss-specifications.com/rss-graphics.htm
http://www.feedforall.com/autodiscovery.htm
http://www.small-business-software.net/display-rss.htm
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informed, the ability to maintain high exposure and visibility is gradually shifted from complete attention
to major search engines and content optimization techniques to an increasing awareness of RSS feed
directories and search tools.

In order to increase exposure of an RSS feed it should be submitted to RSS search engines and
directories. This can be done manually. Just as you would submit the URL of a website or web page to a
search engine you will need to submit the link of the actual feed located on your website to the RSS
directories. There is a large list of RSS directories at http://www.rss-specifications.com/rss-
submission.htm . If you prefer to automate the submission process try RSS Submit at:
http://www.dummysoftware.com/rsssubmit.html . An evaluation version is available.

Advanced PHP scripts for RSS feeds and Podcasting
For experienced webmasters we offer several PHP scripts that can be used with RSS feeds.  They allow
webmasters advanced functionality like RSS feed caching, aggregating multiple feeds into one, saving
feeds to an SQL database, and reading feeds back out, hiding items in feeds with future pub dates, etc.
Please see the next section titled "Free PHP Scripts" for more information.
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6 Free PHP Scripts

6.1 Overview

With the purchase of FeedForAll, you gain access to our PHP scripts directory.  It contains several
script that give webmasters enhanced tools to be used with RSS feeds.
Here is a brief description of the currently available scripts:

RSS2HTML - enables webmasters to display the contents of RSS feeds in their HTML webpages.

RSS2HTML Pro - an enhanced version of RSS2HTML with some more advanced features

RSS2HTML Caching - adds caching support to the RSS2HTML script

FutureRSS - allows you to add items to your feed with future Pub Dates, but doesn't allow the future
items to be displayed by subscribers until they are current

RSSMesh - allows webmasters to combine several source RSS feeds into a single feed

RSS2SQL - reads RSS feeds into an SQL database for storage

SQL2RSS - retrieves data from an SQL database and creates an RSS feed with the results
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6.2 RSS2HTML

RSS2HTML PHP Script Documentation v2.1

Contents
  Introduction
  Uses
  Quick Start
  Templates
  Running from FeedForAll's server
  Running on local server
  Example websites
  Advanced Notes
  Restricting Access
  Caching

Introduction:
-------------

FeedForAll has made available a free PHP program called rss2html.php, which can be used by
webmasters to automatically display RSS feeds on their website.  The resulting webpage will always
show the RSS feed's most current data.  The advantage of using the rss2html.php script is that the
resulting webpage's contents will always be up to date, and can be easily spidered by search engines.

Uses:
-----

- Create a webpage with an RSS feed's information
- Insert an RSS feed's information into a location in an existing webpage

Quick Start:
------------

rss2html.php has a built in utility to help get started quickly.  This is done by calling rss2html.php with
the parameter "buildURL", for example http://scripts.rss2html.com/public/rss2html.php?buildURL .  After
filling in the information about your feed and template you will be shown the exact code to include the
output of rss2html.php into a webpage.

Templates:
----------

FeedForAll's rss2html.php script uses templates to generate its output.  The templates allow you to
easily control what the resulting webpage will look like.  A template can be used to generate a complete
webpage, or a portion of a webpage like a table (which can then be included inside an existing webpage).
The template's syntax is exactly the same as the syntax used in FeedForAll's export functions.

Templates are simply standard HTML documents, with special variables inserted where the RSS feed's
data should appear.  Usually the easiest way to create a template is to create a sample webpage with
some real data in it, and then replace the feed's data with template variables, or modify an existing
webpage, by adding template variables.  Here is a list of the variables supported by FeedForAll's
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rss2html.php script:

~~~FeedTitle~~~  (The feed's title)
~~~FeedDescription~~~  (the feed's description)
~~~FeedContentEncoded~~~ (the feed's description from optional ContentEncoded field)
~~~FeedLink~~~  (the feed's link)
~~~FeedPubDate~~~  (the feed's pub date/time in RSS format)
~~~FeedPubLongDate~~~  (the feed's date in your Windows long date format)
~~~FeedPubShortDate~~~ (the feed's date in your Windows short date format)
~~~FeedPubLongTime~~~  (the feed's time in your Windows long time format)
~~~FeedPubShortTime~~~  (the feed's time in your Windows short time format)
~~~FeedCreativeCommons~~~ (the feed's Creative Commons(R) License URL if one exists)
~~~FeedImageUrl~~~  (the URL to the feed's image)
~~~FeedImageTitle~~~  (the title for the feed's image)
~~~FeedImageLink~~~  (the link associated with the feed's image)

~~~FeedMaxItems=X~~~ (the maximum number of items to appear on the webpage - replace 'X' with a
number. The first 'X' number of items in the feed will be displayed. Using a negative number for 'X' will
show the last 'X' items from a feed.
~~~SortByPubDate~~~  (the items will be sorted by their PubDate, before they are displayed - newest
first)
~~~NoFutureItems~~~  (items with PubDates that are in the future won't be displayed until that
date/time arrives)

~~~BeginItemsRecord~~~  (repeat everything between this and the end marker, for each item)
~~~EndItemsRecord~~~  (repeat everything between this and the start marker, for each item)
~~~BeginAlternateItemsRecord~~~  (separates the ItemsRecord into alternating halves)

~~~ItemTitle~~~  (the item's title)
~~~ItemDescription~~~  (the item's description)
~~~ItemContentEncoded~~~ (the item's description from optional ContentEncoded field)
~~~ItemLink~~~  (the item's link)
~~~ItemPubDate~~~  (the item's pub date/time in RSS format)
~~~ItemPubLongDate~~~  (the items's date in your Windows long date format)
~~~ItemPubShortDate~~~   (the item's date in your Windows short date format)
~~~ItemPubLongTime~~~  (the item's time in your Windows long time format)
~~~ItemPubShortTime~~~  (the item's time in your Windows short time format)
~~~ItemEnclosureUrl~~~  (the item's enclosure URL)
~~~ItemEnclosureType~~~  (the item's enclosure MIME type)
~~~ItemEnclosureLength~~~  (the item's enclosure Length)
~~~ItemEnclosureLengthFormatted~~~  (the item's enclosure Length formatted into Kilo, Mega or Giga
Bytes)
~~~ItemGuid~~~ (the item's GUID field value)
~~~ItemAuthor~~~ (the item's author field value)
~~~ItemComments~~~ (the item's comments field value)
~~~ItemSource~~~ (the item's source field value)
~~~ItemSourceUrl~~~ (the item's source url attribute value)
~~~ItemCategory~~~ (the first item's category field value)
~~~ItemCategoryDomain~~~ (the item's first category domain attribute value)
~~~ItemCreativeCommons~~~  (The Creative Commons(R) License URL of the item, or feed if there isn't
one on the item but there is on the feed)

When the rss2html.php script runs, it will substitute information from the RSS feed into the location
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wherever a variable is found.  For example, every time ~~~FeedTitle~~~ is found in the template's text,
the Title from the RSS feed will be substituted.

Special variables:
The ~~~FeedMaxItems=X~~~ variable can be used to limit the number of items that will be inserted into
the webpage.  Replace the 'X' with a number of feed items you would like displayed (no spaces).

The ~~~BeginItemsRecord~~~ is used to mark the beginning of the section in the template, that should
be repeated for each item in the RSS feed.  A corresponding ~~~EndItemsRecord~~~ should be used to
mark the end of the repeating section.  Everything inv between these two variables will be repeated for
every item in the feed.  You would typically place all your ~~~Item...~~~ variables in between the
~~~BeginItemsRecord~~~ and ~~~EndItemsRecord~~~ variables.

The ~~~BeginAlternateItemsRecord~~~ tag is optional, and can be used in between the
~~~BeginItemsRecord~~~ and ~~~EndItemsRecord~~~ variables to split the section into two halves.
Everything between the ~~~BeginItemsRecord~~~ and the ~~~BeginAlternateItemsRecord~~~ will be
used for odd numbered RSS feed items, and everything between the ~~~BeginAlternateItemsRecord~~~
and the ~~~EndItemsRecord~~~ will be used for even numbered RSS feed items.  This is typically used
to give alternating feed items a slightly different look.

Example - template used to generate a complete HTML webpage:

<HTML>
    <HEAD>
        <TITLE>~~~FeedTitle~~~</TITLE>
    </HEAD>
    <BODY>
        <H1>~~~FeedTitle~~~</H1>
        <BR>
        <H2>~~~FeedDescription~~~</H2>
        <BR>
        <TABLE width="100%">
            ~~~BeginItemsRecord~~~
            <TR>
                <TD>
                    <B>~~~ItemTitle~~~</B>
                </TD>
            </TR>
            <TR>
                <TD>
                    ~~~ItemDescription~~~
                </TD>
            </TR>
            <TR>
                <TD>
                    <BR>
                </TD>
            </TR>
            ~~~EndItemsRecord~~~
        </TABLE>
    </BODY>
</HTML>
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Example - template used to generate an HTML table, for including inside existing webpage*

<TABLE WIDTH="100%">
    ~~~BeginItemsRecord~~~
    <TR VALIGN="TOP">
        <TD>
            <BR>

    <FONT SIZE="-1">~~~ItemPubShortDate~~~ </FONT><BR>
            <B>~~~ItemTitle~~~</B><BR>
            ~~~ItemDescription~~~<BR>
            <BR>
            <A HREF="~~~ItemLink~~~">more info</A>
            <BR><BR>
        </TD>
    </TR>
    ~~~EndItemsRecord~~~
</TABLE>

*Server-side includes, imbedded PHP code, and other inclusion methods are outside the scope of this
document.

Running rss2html.php from FeedForAll's public server:
-----------------------------------------------------

If your webserver doesn't support PHP, then you can run the rss2html.php script on FeedForAll's public
server instead.  All you need to do is setup a link on your website to access the script and resulting
webpage.

rss2html.php has a built in utility to help create the URLs and trouble shoot problems.  It is available by
adding ?buildURL,

http://scripts.rss2html.com/public/rss2html.php?buildURL

Syntax:

http://scripts.rss2html.com/public/rss2html.php?XMLFILE=<your-rss-feed>&TEMPLATE=<your-
template>&MAXITEMS=<max-items>

The above URL should all be on one line, with no spaces.

Replace '<your-rss-feed>' with the full URL to your RSS feed (i.e.
http://www.mydomain.com/myfeed.xml)

Replace '<your-template>' with the full URL to the webpage template you want to use (i.e.
http://www.mydomain.com/mytemplate.htm)

Replace '<max-items>' with the maximum number of items from your RSS feed you want included on the
webpage.  The MAXITEMS variable is optional.  If it is not included, all the RSS feed items will be
included.
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Sample:

http://scripts.rss2html.com/public/rss2html.php?XMLFILE=http://www.feedforall.com/blog-
feed.xml&TEMPLATE=http://www.feedforall.com/sample-template.html

The above URL should all be on one line, with no spaces.

Running rss2html.php from your own webserver:
---------------------------------------------

Probably the best way to use rss2html.php is to upload it to your own webserver.  This gives you two
ways to access the script.  First, you can setup a link on your webpage to access the script and
resulting webpage.

Syntax:
http://<your-domain>/rss2html.php?XMLFILE=<your-rss-feed>&TEMPLATE=<your-
template>&MAXITEMS=<max-items>

The above URL should all be on one line, with no spaces.

Replace '<your-domain>' with the domain of your website

Replace '<your-rss-feed>' with the full URL to your RSS feed (i.e.
http://www.mydomain.com/myfeed.xml)

Replace '<your-template>' with the full URL to the webpage template you want to use (i.e.
http://www.mydomain.com/mytemplate.htm)

Replace '<max-items>' with the maximum number of items from your RSS feed you want included on the
webpage.  The MAXITEMS variable is optional.  If it is not included, all the RSS feed items will be
included.

Sample:

http://feedforall.com/rss2html.php?XMLFILE=blog-feed.xml&TEMPLATE=sample-
template.html&MAXITEMS=10

The second option is to edit the settings inside of the rss2html.php script itself, and then just access the
script as if it were a regular webpage.

With a text editor open up the rss2html.php file. Look for the line near the beginning that looks like this:

$XMLfilename = "sample.xml";

Replace sample.xml with either the local path or full URL to your RSS feed file.

Next, find the line that looks like this:

$TEMPLATEfilename = "BasicWebpage.htm";

Replace BasicWebpage.htm with either the local path or full URL to your template file.
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Finally, if you want to specify the maximum number of items to include from your feed, find the line that
looks like this:

$FeedMaxItems = 10000;

Replace 10000 with the maximum number of items you want.

Save the file with a new name (what you want to call it on your website), but make sure to keep the .php
extension.

For example, if you named it 'myfeed.php', you can now access it from your browser by typing:
http://<your-domain.com>/myfeed.php

Sample:

http://www.feedforall.com/blog.php

Examples of the RSS to HTML PHP script in action:

http://www.feedforall.com/blog.htm (FeedForAll's main RSS feed, using the rss2html.php script)

http://www.feedforall.com/public/layouts.htm (lots of sample pages)

http://www.small-business-software-net (the main page is actually the rss2html.php script being run)

http://www.create-rss.com (the main page is actually the rss2html.php script being run)

Advanced Notes:
---------------

Version 2.0 and later of this script use the PHP curl function to open feeds and templates.  Earlier
versions used fopen.  If you need to use fopen for any reason, there is a setting at the beginning of the
script that can be changed, to force that behavior.

Sometimes the URL of a feed you want to use with rss2html.php contains illegal characters in it. For
example, you can' t use spaces, question marks, ampersands, etc in an URL. The solution is to use
encoded characters in their place. The best way to do this is with a built in utility,
rss2html.php?buildURL . Here is a list of illegal characters and their equivalent encodings:

% -> %25
? -> %3f
& -> %26
= -> %3d
+ -> %2b
<SPACE> -> %20

For example this feed's URL:

http://www.mynewssource.com/opensearch.php?query=pike+fishing&search=Search&type=search

Should look like this in a call to rss2html.php:
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http://www.rss2html.com/public/rss2html.php?XMLFILE=http://www.mynewssource.com/opensearch.php
%3fquery%3dpike%2bfishing%26search%3dSearch%26type%3dsearch

Restricting Access:
-------------------

The rss2html.php script now offers the ability to control if the feed and template are local or remote.
Local files can be limited to specific file extensions.  File access is controlled by the variable
$fileAccessLevel, the default value is 1.

File access level:
 -1 = Remote files are NOT allowed, only local files allowed for template
      and feed which have filenames ending in extensions in the
      $allowedTemplateExtensions and $allowedFeedExtensions lists below
  0 = Remote files and any local files allowed for template and feed
  1 = Remote files and only local files allowed for template and feed
      which have filenames ending in extensions in the
      $allowedTemplateExtensions and $allowedFeedExtensions lists below
  2 = No local files allowed, remote files only.

Allowed file extensions is a list of the allowable extensions for local for the template and the feed.  Below
are the default values of both of the arrays:

$allowedTemplateExtensions = Array(".html", ".htm", ".shtml");
$allowedFeedExtensions = Array(".xml", ".rss");

Caching:
--------

There is now a caching module available for use with rss2html.  It caches the source RSS feed on your
local server (if your are running rss2html.php on your local server).  This can noticeably speed up page
displays, and reduce bandwidth usage.  The caching module is available to all registered users of
FeedForAll or FeedForAll Mac.  It can be downloaded from here:
http://www.feedforall.com/rss-cache.htm

Copyright 2005-2006 NotePage, Inc. All rights reserved
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6.3 RSS2HTML Pro

RSS2HTML-PRO PHP Script Documentation

CONTENTS:
  Introduction
  Uses
  Limitations
  Use in Templates
  Unique Item Link

Introduction:
-------------

RSS2HTML-PRO allow PHP code to be included in the template of RSS2HTML.  This PHP code can be
used to perform logic and processing that is not available in the free version of RSS2HTML.

Uses:
-----

- Filter the items displayed by words or phrases
- Filter the display of items by time or date ranges
- Modify the contents of the RSS Feed

Limitations:
-------------

PHP is a programming language (http://www.php.net/manual/en/introduction.php) that can be used on
webservers.  As such, to use the features of RSS2HTML-PRO you will need to know how to program in
PHP, or be familiar with programming and able to learn PHP.

RSS2HTML-PRO does not support the short PHP tags, for reasons noted on
http://us3.php.net/manual/en/language.basic-syntax.php.  Only the "<?php ?>" and "<?= ?>" PHP tags
are supported.

Use in Templates:
-----------------

RSS2HTML does the substitutions into the template of the RSS feed values into the special ~~~X~~~
place holders in the template.  After the whole feed has been parsed and the output of RSS2HTML is
complete, it is then passed to the RSS2HTML-PRO module for parsing.  Since the result of replacing the
~~~X~~~ place holders produce raw strings, they must be placed inside of quotation marks for use in
PHP.  To prevent an quotation marks in the RSS feed values causing problems, RSS2HTML-PRO
converts all quotation marks to the special value of ~~~QUOTE~~~ before processing.  Then after
processing all ~~~QUOTE~~~s are converted back to quotation marks.

Unique Item Link:
-----------------
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RSS2HTML-PRO provides the capability to create a link that points to a specific item, allowing just that
item to be displayed.  This is done by placing ~~~ItemUniqueLinkWithTemplate=X~~~ into the template.
A link to the item will be created using the template 'X'.  This can be used to create a web page for the
item showing more information than what was show on the page with all the items from the feed.
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6.4 RSS2HTML Caching

Caching Module for rss2hml.php and rssMesh.php Documentation V1.7

Contents
  Introduction
  Requirements
  Usage

Introduction:

The caching module gives users of the rss2html.php and rssMesh script the ability to have their source
RSS feeds cached, significantly speeding up web page display time.  Once the feed is cached it will be
read from the local hard drive for a specified amount of time. After the specified time has lapsed, the RSS
feed will be fetched again. This allows the contents of the RSS feed being displayed to remain current,
while expediting the whole process.  Additionally, the script reduces bandwidth usage. The bandwidth is
reduced because the web server does not have to repeatedly fetch the same RSS feed from a remote
server.  Another benefit to using the new caching module is that on occasion a website will forbid access
to their RSS feeds from websites or IP addresses that request the feeds too frequently. The caching
module will assist in these situations, because RSS feed requests will be minimized.

The caching module is available for free for all registered users of FeedForAll or FeedForAll Mac, and can
be downloaded from here: http://www.feedforall.com/rss-cache.htm

Requirements:

1. A working version of rss2html.php version 2.21 or newer
or
1a. A working version of rssMesh.php version 1.16 or newer

2. A copy of FeedForAll_Scripts_CachingExtension.php version 1.7 or newer

Usage:

1. Copy FeedForAll_Scripts_CachingExtension.php to the same directory on your web server that
rss2html.php or rssMesh.php is in.
2.  Create a directory beneath that directory named "FeedForAllCacheFiles", and make sure the web
server has permissions to write to it.  This folder is required, because it is where the RSS feed XML files
are cached.
2a. Example - On a Unix like operating systems this can be done with the following commands:
    mkdir FeedForAllCacheFiles
    chmod 777 FeedForAllCacheFiles
3.  Edit either your rss2html.php file or your rssMesh.php file and change the line
"$allowCachingXMLFiles = 0;" to "$allowCachingXMLFiles = 1;" if the value isn't already set to 1.
4.  By default a cached file has a life of 24 hours.  If you wish to change the interval, edit
FeedForAll_Scripts_CachingExtension.php and change
"$cacheTTL=86400;   //cache files for 1 day" to what ever value you wish.  $cacheTTL is in seconds.
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6.5 FutureRSS

Future RSS PHP Script Documentation

Version 1.0

Description:
The future-rss.php script is used to automatically delay the publication of Items in an RSS feed.  This
allows Items in a RSS feed to be created ahead of time, and then slowly released over a period of time.
Many people have tried to set the PubDate field on their RSS feed Items to a future date and time, in an
attempt to have that particular item become 'visible' to their feed's subscribers on that particular date and
time.  Unfortunately, they will soon find out that many RSS readers and aggregators don't honor future
PubDates, and immediately show all their feed's items.  The future-rss.php script 'hides' the future items
from RSS feed readers and aggregators, until their PubDate becomes current.

How it Works:
Point the future-rss.php script to your RSS feed's location (either using a local path, or an URL), and
then use the URL of the future-rss.php script as your feed's address (the link you make available to your
users).

Example Usage:
Let's say you have an existing RSS feed at http://www.mydomain.com/myfeed.xml that you want to add
bulk content to, and then have it automatically make a new item available each day.

1. The first thing you would do is set the PubDate field for each of the feed's items to a future day (each
item, one more day into the future).

2. Next, copy the future-rss.php script into the same folder on your webserver as your feed.

3. With a text editor, edit the source of the future-rss.php script, and change the line near the beginning
of the script that reads:

$cfg["rss_feed"]='rss.xml';

to

$cfg["rss_feed"]='myfeed.xml';

*Note: you can use an URL in this line if the feed is on a remote computer

5. You might want to rename the script from 'future-rss.php' to something more similar to your feed's title,
like 'myfeed.php', in this case.

6. To test, simply enter the URL of the script into a browser.

Copyright & License Info:
Copyright 2005,2006 NotePage, Inc. all rights reserved
http://www.feedforall.com
NotePage, Inc. grants registered users of our FeedForAll and/or
FeedForAll Mac product(s) the right to install and use the
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future-rss.php script free of charge.  Please refer to the EULA
included in the download for full license terms and conditions.
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6.6 RSSMesh

rssMesh v1.x Instructions

1) Unzip the contents of the rssMesh.zip file, and copy the extracted files to a folder on your webserver.
The folder should be accessible from the Internet, like your regular webpages.  In fact, the destination
folder could be the same folder that you keep your webpages in.

2) In your browser, enter the full URL to the location of the rssMesh file, and use 'buildConfig' for a
parameter.
Example: http://www.feedforall.com/rssMesh.php?buildConfig
This will bring up the configuration screen for rssMesh

3) On the configuration screen, choose the options you want, and enter the feeds you want to use for
sources.

4) Hit the 'Generate configuration data' button at the bottom of the screen.

5) The screen will refresh and display the contents of a new configuration file in your browser.  You now
need to highlight that data, and copy it to an editor on your local computer (like notepad).

6) Save the new configuration file locally, being sure to use .php for the extension.

7) Upload the configuration file, and put it into the same folder as your rssMesh.php file

8) Test rssMesh by entering its URL into your browser, and including your new config file as a parameter.
The config file must be a local file, if it is specified with a URL it will not work.

Example: http://www.feedforall.com/rssMesh.php?CONFIGFILE=mynewconfig.php
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6.7 RSS2SQL

RSS2SQL v1.x Instructions

Introduction:
=============

RSS2SQL is used to store the contents of RSS feeds in a database.  Once the items from the feeds are
in the database sql2rss could be used to produce new feeds, possibly based on complex selection
criteria.  RSS2SQL has several modules.  rss2sql_admin.php is used to administer the feeds that are
used to populate the database.  rss2sql.php is used to build configuration files and parse the feeds into
the database.  rss2sql_install.php will create the database configuration file.  Using automatic task
scheduling, like cron(1), can be used to call rss2sql.php on a regular basis to automatically update the
newest items from the feed into the database.

Installation:
=============

1) Unzip the contents of the rss2sql.zip file, and copy the extracted files to a folder on your web server.
The folder should be accessible from the Internet, like your regular web pages.  In fact, the destination
folder could be the same folder that you keep your web pages in.

2) In your browser, enter the full URL to the location of the rss2sql files, and run the install module
(rss2sql_install.php).

Example: http://www.FeedForAll.com/rss2sql_install.php

This will bring up a page for the creation of the parameters needed to access your database and the
administration module.  You will need the configuration file name later, you can keep the default of
"rss2sql_DBconfig.inc.php".

3) Hit the 'Submit' button at the bottom of the screen.

4) The screen will refresh and display the contents of a new configuration file in your browser.  You now
need to highlight that data, and copy it to an editor on your local computer (like notepad).

5) Save the new configuration file locally, being sure to use .php for the extension.

6) Upload the configuration file, and put it into the same folder as your rss2sql.php file

7) In your browser, enter the full URL to the location of the rss2sql file, and use 'buildConfig' for a
parameter.

Example: http://www.FeedForAll.com/rss2sql.php?buildConfig

This will bring up the configuration screen for rss2sql

8) There are a lot of fields on this screen.  Unless you very experienced with databases and have specific
requirements it is suggested you keep all of the defaults.  The default field names match the field names
used by rss2html.php.

9) Hit the 'Generate configuration data' button at the bottom of the screen.
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10) The screen will refresh and display the contents of a new configuration file in your browser.  You now
need to highlight that data, and copy it to an editor on your local computer (like notepad).

11) Save the new configuration file locally, being sure to use .php for the extension.

12) Upload the configuration file, and put it into the same folder as your rss2sql.php file

13) On the page will also be the code to create the two database tables that are needed by rss2sql.  You
can copy this code into the command-line utility for you database.

14) After the database tables are created you can then start adding feeds into the system.  This is done
with the rss2sql.php program.

Example: http://www.FeedForAll.com/rss2sql_admin.php

15) You will need the admin username and password from step #2, they are case sensitive.

16) Click on "Add new feed"

17) Fill in the feed's URL.  Change the "Update Interval" to the number of seconds between update if you
are using automatic updates, otherwise set it to 1.

18) Click "Submit"

19) To cause the feed to be parsed and stored in the database use rss2sql.php

Example: http://www.FeedForAll.com/rss2sql.php

Automatic Updating:
===================

If you want to have the contents of your database to be automatically updated when feeds change and
your ISP is using a Un*x operating system, like FreeBSD, Linux, OS X, Solaris, etc., you can use
cron(1) call rss2sql.php on a regular basis.  It is not recommended that you try and fetch the feeds too
often, doing so will put a load on the web server producing the feed and may cause your access to that
web server be blocked.

There are many different ways to force the rss2sql.php program to run from the command line.  You will
need to first see what programs you host offers and where they are.  The three most popular are lynx,
wget and fetch.  To find if they exist are where they are use the following commands:

whereis lynx
whereis wget
whereis fetch

You will need the correct paths for you host, but I will show paths based on the most common location
from here on.  When running these in cron(1) you will probably not want any output so sample command
lines are:

/usr/local/bin/lynx -source http://www.FeedForAll.com/rss2sql.php > /dev/null

/usr/local/bin/wget -O - http://www.FeedForAll.com/rss2sql.php > /dev/null
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/usr/bin/fetch -o - http://www.FeedForAll.com/rss2sql.php > /dev/null

So if you wanted to check each of the feeds for updated once per hour at 13 minutes after, you could use
the following sample crontab(5) entries:

13 * * * *   /usr/local/bin/lynx -source http://www.FeedForAll.com/rss2sql.php > /dev/null

13 * * * *   /usr/local/bin/wget -O - http://www.FeedForAll.com/rss2sql.php > /dev/null

13 * * * *   /usr/bin/fetch -o - http://www.FeedForAll.com/rss2sql.php > /dev/null
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6.8 SQL2RSS

sql2rss v1.x Instructions

1) Unzip the contents of the sql2rss.zip file, and copy the extracted files to a folder on your webserver.
The folder should be accessible from the Internet, like your regular webpages.  In fact, the destination
folder could be the same folder that you keep your webpages in.

2) In your browser, enter the full URL to the location of the sql2rss files, and run the install module
(rss2sql_install.php).

Example: http://www.feedforall.com/sql2rss_install.php

This will bring up a page for the creation of the parameters needed to access your database.  You will
need the configuration file name later, you can keep the default of "sql2rss_DBconfig.inc.php".

3) In your browser, enter the full URL to the location of the sql2rss file, and use 'buildConfig' for a
parameter.

Example: http://www.feedforall.com/sql2rss.php?buildConfig

This will bring up the configuration screen for sql2rss

4) On the configuration screen, enter the names of the two template files and a valid SQL query

5) Hit the 'Generate configuration data' button at the bottom of the screen.

6) The screen will refresh and display the contents of a new configuration file in your browser.  You now
need to highlight that data, and copy it to an editor on your local computer (like notepad).

7) Save the new configuration file locally, being sure to use .php for the extension.

8) Upload the configuration file, and put it into the same folder as your sql2rss.php file

9) Test sql2rss by entering its URL into your browser, and including your new config file as a parameter.
Example: http://www.feedforall.com/sql2rss.php?CONFIGFILE=mynewconfig.php

Channel Template:
=================

The channel template file must be a valid RSS 2.0 feed with only the <channel> level tags, without and
<item>'s.  It will be copied without doing any substitutions, with a <pubData> and <lastBuildDate> set to
the current time.

Item Template:
==============

The item template must contain a single valid RSS 2.0 <item>.  Any text between a pair of "~~~" will be
substituted with the contents of the database field of that name, if any.  There is one special tag
"~~~RSSDATE(fieldname)~~~" which will take the contents of the database "fieldname", which must be
a date, and convert it to a valid RFC 822 date format needed by RSS 2.0.
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7 Registration

7.1 Overview

The evaluation version of FeedForAll allows you to try it for 30 days.  After that FeedForAll no longer
allows you to use the program unless you enter registration information that you receive after purchasing
it.  If you purchase a license before the evaluation period is up, you can access the registration screen
from the main menu.

IMPORTANT: The registration information must be entered EXACTLY as it appears in the email you
receive after purchasing FeedForAll.  ALL the fields must be entered (i.e. Company Name, Address,
Country, etc.).

The easiest way to enter the registration information is to highlight the entire email message you receive
from us, and copy it to the Windows clipboard.  You can then use the 'Paste Registration From
Clipboard' button on FeedForAll's registration screen, to have the information automatically entered for
you.
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8 Reference

8.1 Field Descriptions

8.1.1 Feed Fields

8.1.1.1 Title

Field Description:
The name for the feed.

Field Usage:
Required in all feeds.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.2 Description

Field Description:
A phrase or sentence that describes the feed.

Field Usage:
Required in all feeds.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.3 Link

Field Description:
The URL for the webpage containing information that directly relates to the feed. The proper syntax for
the URL is to use the fully specified address that includes the scheme.

For example:
http://www.FeedForAll.com/feedforall-mac.htm

Field Usage:
Required in all feeds.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.4 Pub Date

Field Description:
The date and time when the feed's content is to be published. Some feed readers may choose not to
display a feed until it's Pub Date has arrived.

Field Usage:
Optional, but is strongly suggested.

Reference:
http://blogs.law.harvard.edu/tech/rss

http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
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8.1.1.5 Skip Hours

Field Description:
Hours of the day (0 = midnight) that the feed readers do not need to check for changes in the feed.
Feed readers can use this to save time when checking for updates.

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.6 Skip Days

Field Description:
Days of the week that feed readers do not need to check for changes in the feed. Feed readers can
use this to save time when checking for updates.

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.7 Language

Field Description:
The language the feed is written in.

Field Usage:
This is an optional field. However, when creating a podcast for the iTunes® Music Store it is required.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.8 Category

Field Description:
Some RSS directories allow users to search for feeds that they are interested in, by category.
Category has one optional attribute.

category:
The name of a category that the feed belongs to.  This value will can be used alone, or if the domain
field is use, it should be a valid option from that domain's categories

domain:
A string that identifies the taxonomy for categorization.

You can create your own categories, but typically you will want to use a more standard predefined
category. DMOZ is probably the most popular category system.

Example DMOZ category: Computers/Internet/On_the_Web/Weblogs/Tools

If a predefined category is used (i.e. from DMOZ), you should set the category domain field to point to
the category system's website.

http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
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Example DMOZ domain: http://www.dmoz.org

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.9 Cloud

Field Description:
The Cloud settings enable a feed reader to register with a cloud server, to receive notification when a
feed has changed. This removes the need for the reader to periodically access the feed to check for
updates.

Several pieces of information need to be entered to setup you feed for a cloud server.

Domain:
The domain name or IP address of the cloud server.

Port:
The TCP/IP port number that the cloud server is running on.

Path:
The location of the cloud server's responder.

Reg Proc:
Registration Procedure - the name of the procedure to call to request notification.

Protocol:
The protocol to use to communicate with the cloud server (xml-rpc, soap, or http-post).

Field Usage:
All the cloud fields are optional.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.10 Text Input

Field Description:
The Text Input settings allows a data entry box to be displayed within your feed. It can be used to collect
information from the reader, or act on data they enter. Not all feed readers support this option.

Several pieces of information need to be entered to setup a Text Input box in your feed.

Title:
A title for the Text Input box.

Description:
A short description of what the user should enter into the Text Input box.

Name:
The variable name assigned to the input box.

http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
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Link:
The URL to a CGI program that is to receive the data from the Text Input box. The proper syntax for
the URL is to use the fully specified address that includes the scheme.

Field Usage:
Including a Text Input with your feed is optional. However, if you enter information is any Text Input
field, then you must enter proper information into all the Text Input fields.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.11 Webmaster

Field Description:
The email address for the person responsible for technical issues relating to the feed.

Including a name for the email address in this field is optional. The proper syntax for doing so would
be: user@myemail.com (John Doe)

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.12 Editor

Field Description:
The email address for the person responsible for the feed's content.

Including a name for the email address in this field is optional. The proper syntax for doing so would
be: user@myemail.com (John Doe)

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.13 Copyright

Field Description:
Copyright notice for the contents of the feed.

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.14 Rating

Field Description:
A Platform for Internet Content Selection (PICS) rating tag.

Field Usage:

http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss


FeedForAll v2.085

© 2004-2006 NotePage, Inc.

This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss
PICS: http://www.w3.org/PICS/

8.1.1.15 Docs

Field Description:
The URL for a webpage that describes the specification for this version of the RSS format.

Example: http://blogs/law.harvard.edu/tech/rss

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.16 TTL

Field Description:
The number of minutes that the feed is allowed to be cached by a server (other than the actual server
the feed is posted on), before the feed needs to be refreshed. This value is used by services that cache
RSS feeds.

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.1.17 Extensions

The 'Extensions' tab is used to set up namespace definitions for podcasting your feeds.

Visit http://www.feedforall.com/directory-namespace.htm for namespace definitions of popular podcasting
services, or create your own.  Here is a list of some of the namespace definitions available on our web
site:

·  iTunes (Apple)
·  Media RSS (Yahoo)
·  Simple Lists (Microsoft)
·  blogChannel (Winer)
·  TrackBack
·  Creative Commons
·  GeoRSS ( WorldKit)
·  Content
·  Syndication
·  Dublin Core (DC)
·  Google Base (Google)
·  Simple Sharing Extensions (Microsoft)

http://blogs.law.harvard.edu/tech/rss
http://www.myhomepage.com/index.html
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://www.feedforall.com/directory-namespace.htm
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8.1.1.18 XML Comments

Comments can be added to the XML code of your feed.  These comments aren't typically seen by
subscribers.

8.1.1.19 Stylesheet

A stylesheet can be associated with an RSS feed.  This will allow browsers to display your feed in a
more formatted way.  Each feed can have an XSL stylesheet, or a CSS stylesheet.

8.1.2 Item Fields

Each feed must contain at least one valid item entry.

8.1.2.1 Title

Field Description:
The headline for the item's content.

Field Usage:
Every item must have at least a Title or a Description (or both).

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.2 Description

Field Description:
A summary of the full content that the item was created to represent.

Field Usage:
Every item must have at least a Title or a Description (or both).

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.3 Link

Field Description:
The URL for the webpage, or for the section of a webpage, that contains the item's full content. Feed
readers will typically display the webpage described by this URL, when a user clicks on the item. The
proper syntax for the URL is to use the fully specified address that includes the scheme.

Field Usage:
This is an optional field

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.4 Pub Date

Field Description:
The date and time when the item is to be made available. Some feed readers may choose not to
display an item until its Pub Date date has arrived.

Field Usage:
This is an optional field.

http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
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Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.5 Category

Field Description:
Some RSS directories allow users to search for feed's items that they are interested in, by category.
Category has one optional attribute.

Category:
The name of a category that the feed belongs to.  This value will can be used alone, or if the domain
field is use, it should be a valid option from that domain's categories

Domain:
A string that identifies the taxonomy for categorization.

You can create your own categories, but typically you will want to use a more standard predefined
category. DMOZ is probably the most popular category system.

Example DMOZ category: Computers/Internet/On_the_Web/Weblogs/Tools

If a predefined category is used (i.e. from DMOZ), you should set the category domain field to point to
the category system's website.

Example DMOZ domain: http://www.dmoz.org

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.6 GUID

Field Description:
The GUID (Globally Unique Identifier), is a string that uniquely identifies the item. When present, a feed
reader may choose to use this string to determine if an item is new.

When the 'Is Perma Link' box is checked, feed readers will assume that the GUID is a unique URL for
the item, and can be opened to display the full contents for the item.

Field Usage:
This is an optional field. However, this field is strongly recommended for all feeds, including iTunes®
podcasts.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.7 Source

Field Description:
If the item was obtained from another feed, then the source feed's information is entered here. Source
has one required attribute.

Source:

http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
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The title of the feed that this item came from

Url:
The URL to the RSS feed that the item came from. The proper syntax for the URL is to use the fully
specified address that includes the scheme.

Field Usage:
Including a Source with your feed is optional. However, if you enter information into the source field,
then you must also include information in the URL field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.8 Enclosure

Field Description:
RSS enclosure is part of the RSS 2.0 spec. It allows for the attachment of files via a URL to feed
items. These files are usually in media format. It has three required attributes:

Url:
The URL for the file. The proper syntax for the URL is to use the fully specified address that includes
the scheme.

Length:
The size of the file in bytes.

Type:
The MIME type of the file. Consult the tables below to determine which MIME format is acceptable.

MIME types for iTunes
File   Type 
.mp3   audio/mpeg 
.m4a, .m4b audio/mp4a-latm 
.mp4   video/mp4 
.m4v   video/x-m4v 
.mov   video/quicktime 
.pdf   application/pdf 

MIME types accept by most readers
File   Type 
.mp3 audio/mpeg
.m4a, .m4b audio/mp4a-latm 
.mp4   video/mp4 
.m4v   video/x-m4v 
.mov   video/quicktime 
.mpg   audio/mpeg or video/mpeg 
.ra   audio/x-pn-realaudio 
.mid   audio/midi 
.wav   audio/x-wav 

Field Usage:
Including an Enclosure with your feed is optional. However, if you enter information is any Enclosure
field, then you must enter proper information into all the Enclosure fields.

http://blogs.law.harvard.edu/tech/rss
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Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.9 Author

Field Description:
The email address of the author of the item. Typically, this field is only used if the author is different
than the feed's Editor (Managing Editor).

Including a name for the email address in this field is optional. The proper syntax for doing so would
be: user@myemail.com (John Doe).

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.10 Comments

Field Description:
The URL for a webpage containing (or accepting) comments relating to this item. The proper syntax for
the URL is to use the fully specified address that includes the scheme.

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.2.11 XML Comments

Comments can be added to the XML code of your item.  These comments aren't typically seen by
subscribers.

8.1.3 Image Fields

Each feed can have an image associated with it.  Feed readers typically display this image with the
feed's title.

Images are optional.

8.1.3.1 Title

Field Description:
Typically the same text as the feed's Title.

Field Usage:
If an image is to be included with the feed, then this field is required.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.3.2 Description

Field Description:
The description is used for the HTML 'title' attribute of the image.

http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
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Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.3.3 Link

Field Description:
The URL for the webpage that directly relates to the feed. This is typically the same URL as the feed's
Link field. The proper syntax for the URL is to use the fully specified address that includes the
scheme.

Field Usage:
If an image is to be included with the feed, then this field is required.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.3.4 URL

Field Description:
The URL for the image file. The proper syntax for the URL is to use the fully specified address that
includes the scheme.

Images can be in the following formats: .gif, .jpg, .png

Field Usage:
If an image is to be included with the feed, then this field is required.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.3.5 Width

Field Description:
The width of the image (in pixels). The default width for an RSS image is 88. The maximum allowed
width is 144.

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

8.1.3.6 Height

Field Description:
The height of the image (in pixels). The default height for an RSS image is 31. The maximum allowed
height is 400.

Field Usage:
This is an optional field.

Reference:
http://blogs.law.harvard.edu/tech/rss

http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
http://blogs.law.harvard.edu/tech/rss
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8.1.3.7 XML Comments

Comments can be added to the XML code of your image.  These comments aren't typically seen by
subscribers.

8.1.4 Extensios

8.1.4.1 iTunes

8.1.4.1.1  Feed Fields

8.1.4.1.1.1  Author

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
The contents of this tag is shown in the Artist column in iTunes. It contains the name of the person or
company that is most widely attributed to publishing the podcast.

Field Limitations:
Plain text only, no HTML. Limited to 255 characters.

Field Usage:
Optional, but is strongly suggested. If blank, then the value of the <managingEditor> will be used and
must have a value.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.1.2  Block

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
Use this inside of the <channel> element (on the Feed level) to prevent the entire podcast from
appearing in the iTunes® Podcast directory.

Field Usage:
This is a required field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.1.3  Category

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag can only be populated using iTunes specific categories, found here. Some categories have
sub categories. You are allowed to have more than one category listed, however iTunes® will take the

http://www.apple.com/itunes/podcasts/techspecs.html
http://www.apple.com/itunes/podcasts/techspecs.html
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first top level category as the primary category for your feed.

Field Usage:
This is a required field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.1.4  Explicit

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag should be used to indicate whether or not your podcast contains explicit material.

If you populate this tag with "Yes", a parental advisory tag will appear next to your Podcast cover
artwork on the iTunes® Music Store, and in the Name column in iTunes. If the value is "Clean", the
parental advisory type is considered clean, meaning that no explicit language or adult content is
included anywhere in the episodes. "Clean" is usually used when there both an "Explicit" and "Clean"
versions of the same song or podcast.

Field Usage:
This is a required field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.1.5  Image

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag specifies the artwork for your podcast. iTunes prefers square images that are at least 300 x
300 pixels, which is different than what is specified for the standard RSS image tag. iTunes supports
images in JPEG and PNG formats. The url must end in ".jpg" or ".png".

The proper syntax for the URL is to use the fully specified address that includes the scheme.

For example:
http://www.FeedForAll.com/image/emblem.jpg

Field Usage:
Optional, but is strongly suggested. If blank, then the value of the <image> will be used and must have
a value.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

http://www.apple.com/itunes/podcasts/techspecs.html
http://www.apple.com/itunes/podcasts/techspecs.html
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8.1.4.1.1.6  Keywords

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag allows users to search on text keywords. Use commas to separate the keywords or phrases.

Field Limitations:
Plain text only, no HTML. Limited to 255 characters.

Field Usage:
This is an optional field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.1.7  New Feed Url

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag allows you to change the URL (web server location) where the podcast feed is located. This
should only be used when the URL to access your podcast is changed. The new URL of your feed is
entered in this field and should remain accessible at the old URL for at least 48 hours.

Field Usage:
This is an optional field except when changing the location of a feed uploaded as a podcast for the
iTunes® Music Store.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.1.8  Owner Email

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag contains information that will be used by the iTunes® Music Store staff to contact the owner
of the podcast for communication specifically about their podcast. It will not be publicly displayed.

Field Limitations:
Plain text only, no HTML. Limited to 255 characters.

Field Usage:
This field is required.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

http://www.apple.com/itunes/podcasts/techspecs.html
http://www.apple.com/itunes/podcasts/techspecs.html
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8.1.4.1.1.9  Owner Name

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag contains information that will be used by the iTunes® Music Store staff to contact the owner
of the podcast for communication specifically about their podcast. It will not be publicly displayed.

Field Limitations:
Plain text only, no HTML. Limited to 255 characters.

Field Usage:
This field is required.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.1.10  Subtitle

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag is a short description, usually on a few words, that provides general information about the
Podcast. It will appear in the Description column in iTunes.

Field Limitations:
Plain text only, no HTML. Limited to 255 characters.

Field Usage:
This is a required field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.1.11  Summary

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
The contents of this tag is a long description of your feed that is displayed in a separate window when
\u24d8(circled i) in Description column is clicked.

Field Limitations:
Plain text only, no HTML. Limited to 4000 characters.

Field Usage:
This is a required field.

Reference:

http://www.apple.com/itunes/podcasts/techspecs.html
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http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.2  Item Fields

8.1.4.1.2.1  Author

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
The contents of this tag is shown in the Artist column in iTunes. It contains the name of the person or
company that is most widely attributed to publishing the podcast.

Field Limitations:
Plain text only, no HTML. Limited to 255 characters.

Field Usage:
Optional, but is strongly suggested. If blank, then the value of the <managingEditor> will be used and
must have a value.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.2.2  Block

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
Use this inside of an <item> to prevent that episode from appearing in the iTunes Podcast directory.

Field Usage:
This is a required field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.2.3  Duration

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag is for informational purposes only and will allow users to know the duration prior to download.

Field Limitations:
The field should be formatted: HH:MM:SS, H:MM:SS, MM:SS, or M:SS (H = hours, M = minutes, S =
seconds).

Field Usage:
This is an required field.

http://www.apple.com/itunes/podcasts/techspecs.html
http://www.apple.com/itunes/podcasts/techspecs.html
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Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.2.4  Explicit

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag should be used to indicate whether or not your podcast contains explicit material.

If you populate this tag with "Yes", a parental advisory tag will appear next to your Podcast cover
artwork on the iTunes® Music Store, and in the Name column in iTunes. If the value is "Clean", the
parental advisory type is considered clean, meaning that no explicit language or adult content is
included anywhere in the episodes. "Clean" is usually used when there both an "Explicit" and "Clean"
versions of the same song or podcast.

Field Usage:
This is a required field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.2.5  Keywords

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag allows users to search on text keywords. Use commas to separate the keywords or phrases.

Field Limitations:
Plain text only, no HTML. Limited to 255 characters.

Field Usage:
This is an optional field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.2.6  Subtitle

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
This tag is a short description, usually on a few words, that provides general information about the
Podcast. It will appear in the Description column in iTunes.

Field Limitations:
Plain text only, no HTML. Limited to 255 characters.

http://www.apple.com/itunes/podcasts/techspecs.html
http://www.apple.com/itunes/podcasts/techspecs.html
http://www.apple.com/itunes/podcasts/techspecs.html
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Field Usage:
This is a required field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.1.2.7  Summary

Namespace:
Name: iTunes® (itunes)
Declaration: xmlns:tunes="http://www.itunes.com/dtds/podcast-1.0.dtd"

Field Description:
The contents of this tag is a long description of your feed that is displayed in a separate window when
\u24d8(circled i) in Description column is clicked.

Field Limitations:
Plain text only, no HTML. Limited to 4000 characters.

Field Usage:
This is a required field.

Reference:
http://www.apple.com/itunes/podcasts/techspecs.html

8.1.4.2 Content

8.1.4.2.1  Encoded

Namespace:
Name: Content
Declaration: xmlns:content="http://purl.org/rss/1.0/modules/content/"

Field Description:
An element whose contents are the entity-encoded or CDATA-escaped version of the content of the
item. This field is commonly used as an alternative to description where <content:encoded> contains
the full text with HTML and description has a shorter summary without HTML.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/content/

8.1.4.3 Dublin Core

8.1.4.3.1  Creator

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The name of the person(s), company, organization, or service responsible for creating the content of
the information in the feed.

http://www.apple.com/itunes/podcasts/techspecs.html
http://www.apple.com/itunes/podcasts/techspecs.html
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Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.2  Contributor

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The name of the person(s), company, organization, or service responsible for making contributions the
information in the feed.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.3  Coverage

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The extent or scope of the content of the resource. Coverage will typically include spatial location (a
place name or geographic coordinates), temporal period (a period label, date, or date range) or
jurisdiction (such as a named administrative entity).

Recommended best practice is to select a value from a controlled vocabulary (for example, the
Thesaurus of Geographic Names [TGN]) and that, where appropriate, named places or time periods be
used in preference to numeric identifiers such as sets of coordinates or date ranges.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/
TGN: http://www.getty.edu/research/conducting_research/vocabularies/tgn/

8.1.4.3.4  Date

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The date of the content or the date that the content was made available as an RSS Feed.

Field Usage:
This field is optional.

http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
http://www.myhomepage.com/index.html
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Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.5  Description

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The explanation including details of the content of the resource. This may include an abstract, table of
contents, etc.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.6  Format

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The media-type or dimensions of the resource. Example of dimensions can include size and duration.
Recommended best practice is to select a value from a controlled vocabulary.

Field Usage:
This field is optional.

Field Location:
This field may be used in <channel>, <textInput>, <image> and/or <item>.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.7  Identifier

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
A number, code, URL, or other unique (unambiguous) reference to the resource within a given content.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
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8.1.4.3.8  Language

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The language in which the feed is written. This value is usually identified by a two letter Language
Code, found here.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/
Languages: http://blogs.law.harvard.edu/tech/stories/storyReader$15

8.1.4.3.9  Publisher

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The name of the person(s), company, organization, or service responsible for making the information in
the feed available in RSS format.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.10  Relation

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
A reference to a related source.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.11  Rights

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:

http://web.resource.org/rss/1.0/modules/dc/
http://www.myhomepage.com/index.html
http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
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Information about the rights held in and over the resource, commonly referred to as copy rights or
property rights.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.12  Source

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The Reference to a resource from which the present source is from using a formal identification
system. Example formal identification systems include the Uniform Resource Identifier (URI) (including
the Uniform Resource Locator (URL), the Digital Object Identifier (DOI) and the International Standard
Book Number (ISBN).

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.13  Subject

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The words or expressions that describe a topic of the content of the resource.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.14  Title

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
The name (title) for the feed, item, or image content.

Field Usage:
This field is optional.

Reference:

http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
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http://web.resource.org/rss/1.0/modules/dc/

8.1.4.3.15  Type

Namespace:
Name: Dublin Core (dc)
Declaration: xmlns:dc="http://purl.org/dc/elements/1.1/"

Field Description:
Terms describing general classifications or categories, or genres for the content. Recommended best
practice is to select a value from a controlled vocabulary. A working draft list of Dublin Core Types can
be found here.

Field Usage:
This field is optional.

Reference:
http://web.resource.org/rss/1.0/modules/dc/
DC Types: http://dublincore.org/documents/dcmi-type-vocabulary/

8.1.4.4 Syndication

8.1.4.4.1  Update Base

Namespace:
Name: Syndication (sy)
Declaration: xmlns:sy="http://purl.org/rss/1.0/modules/syndication/"

Field Description:
This tag combines the values of updatePeriod and updateFrequency to produce a publishing schedule.

Field Limitations:
The value for this field appears as yyy-mm-ddThh:mm.

Field Usage:
This field is required if either updatePeriod or updateFrequency are used.

Reference:
http://web.resource.org/rss/1.0/modules/syndication/

8.1.4.4.2  Update Frequency

Namespace:
Name: Syndication (sy)
Declaration: xmlns:sy="http://purl.org/rss/1.0/modules/syndication/"

Field Description:
This tag works in correlation to updatePeriod, identifying the frequency of the updates.

Field Limitations:
A valid value for this tag is a positive integer greater then zero.

Field Usage:
This field is required if updatePeriod is used.

http://web.resource.org/rss/1.0/modules/dc/
http://web.resource.org/rss/1.0/modules/dc/
http://www.myhomepage.com/index.html
http://web.resource.org/rss/1.0/modules/syndication/
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Reference:
http://web.resource.org/rss/1.0/modules/syndication/

8.1.4.4.3  Update Period

Namespace:
Name: Syndication (sy)
Declaration: xmlns:sy="http://purl.org/rss/1.0/modules/syndication/"

Field Description:
Indicates to aggregators how often the feed's information is updated.

Field Limitations:
Valid values for this tag are: hourly, daily, weekly, monthly, and yearly.

Field Usage:
This field is required if updateBase is used.

Reference:
http://web.resource.org/rss/1.0/modules/syndication/

http://web.resource.org/rss/1.0/modules/syndication/
http://web.resource.org/rss/1.0/modules/syndication/
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9 Support

9.1 FAQ

9.1.1 How do I disable all skins?

1. Click on the 'Preferences' icon in the button bar, or choose 'Tools' -> 'Preferences' from the menu.
2. Click on the 'Display' tab.
3. Check the 'Disable skins' box.

9.1.2 Where can I find the RSS specification?

The official Web site can be found here: http://blogs.law.harvard.edu/tech/rss

9.1.3 I am having trouble uploading my feed

You will need a few pieces of information before you can upload the RSS feed to your Web site.  This
information will most likely be the same information that you needed to upload Web pages, to your Web
server.

1. FTP Server - The address of the FTP server (in many cases this is the domain name of your Web
site).
2. Username - The username you use to log onto the FTP server.
3. Password - The password you use to log onto the FTP server.
4. Path* - The folder on the FTP server you want to put you feed's file into.
5. file name** - The name you want to give your feed's file.

After this information is entered into the 'FTP Upload' screen, click the 'Upload' button to upload your
feed.  If you are not successful uploading, double check the above information, view the FTP log for hints
as to what the problem is, and try switching the 'Mode' setting.  If you still experience problems, the
FeedForAll support forum is a good source of information for this type of problem.

*Path - This one can be a little tricky at times.  This is the path on the FTP server in relation to the folder
you are placed into, by default, when you log onto the FTP server.  This is not a URL (i.e. not
http://www.myserver.com/).  If your Web pages reside in the folder that you are place in when you log
onto the FTP server, then this field should be left blank.  Otherwise, it may look something like
'public_html/'. There are also two things to take notice of.  First, on FTP servers the path separator is a
forward slash '/' not a backslash like on Windows computers.  Second, you shouldn't start the path with
a slash '/' unless you are sure you know the full path to the destination folder from the root of the FTP
server's directory.

** Typically RSS files end with the .XML extension.  Although FTP server can accept files with spaces in
their file name, most Web servers won't allow users to download an RSS feed that has spaces in its file
name. Don't use spaces.

http://blogs.law.harvard.edu/tech/rss
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9.2 Contact Us

FeedForAll is developed by NotePage, Inc.

Contact Information:

Mailing Address NotePage, Inc.
PO Box 296
Hanover, MA  02339

Email Addresses sales@feedforall.com
support@feedforall.com
Webmaster@feedforall.com

Web Page www.feedforall.com

Support Forum www.feedforall.com/forum

http://www.feedforall.com
http://www.feedforall.com/forum
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9.3 Where to Get Help

There are several resources that can help you with using FeedForAll.  This manual is just one of them.

Web sites - Our Web site (www.feedforall.com) contains a wealth of information about the FeedForAll
product.  It is a good place to start when looking for information about FeedForAll or RSS feeds.  Other
RSS specific Web sites can also be a big help (i.e. www.rss-faq.com).

Documentation - The FeedForAll manual can be obtained in several formats.  The manual included in
the product download is in a standard Windows help file format.  You will find an online version of the
manual in the support section of our Web site.  At the same location you will find several downloadable
versions of the manual including: pdf, winhelp, and htmlhelp.

Tech Support - The best place to get technical support for FeedForAll is in our tech support forum
(www.feedforall.com/forum).  You can also send technical support issues to our support email
address(support@feedforall.com).

RSS Informational Resources - If you are new to RSS, or want to learn more about advanced RSS
topics, then an excellent resource is our Educational Article Archive found at:
http://www.feedforall.com/newsletter.htm.  If you have questions about RSS, then this is the place to
look.

http://www.feedforall.com
http://www.rss-faq.com
http://www.feedforall.com/forum
http://www.feedforall.com/newsletter.htm
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